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The gh_ary bch)w defines terms used throughout this manual. Most of these terms find
common use. for discussions of the Apple Macintosh computer's user interface.

button A button is a small screen object, usually labeled with text. The user
clicks on a button to cause the computer to perform an action.

check box A check box represents an option that is either on or off. The user
clicks on the cheek box to alternate between the options.

click '[b position the cur_)r on the computer screen, and then to press and

quickly relea.se the mouse button.

cllrsor A small screen object that follows the movement of the mouse on the

screen.

dialog box A display window which prompts the user for input. A dialog box

remains on the screen until the user dismis_scs it, usually by pointing

to a button-shaped object within the dialog box display and clicking.

double-click To click twice in rapid succession without moving the mouse between
clicks.

d r ag 'lb position the cursor on the screen, press and hold the mouse button

down, move the cursor with the mouse button down to a new location

on the screen, and rclca._ the mouse button.

IllOUSO (]encric term for any hand-operated interface devicc that controls the

location of the cur._.)r on the computer screen. The mouse has a button

which is pregsed by the u.ser, usually to signal the computer to initiate
an action.

point To use the rnouse to indicate a location on the screen.

pop-up menu A mcnu which is accessed via a dialog box or window, as oppposed

to a pull-down menu which is accessed via thc mcnu bar at the top of

the screen. Only the currently _lected menu option is visible; the full

range of menu options appear (i.e., pops-up) when the user points to

the displayed option arid presses the mouse button.

pull-down menu A menu which is accessed via the menu bar at the top of the screen.

The menu bar lists only the menu nam(_; the filll menu becomes visible

(i.e., pulls-down) when the u.ser points the menu name and presses the
rnou_ button.
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Overview

MacPASCO is an interactive, graphic preproccz_or for stiffened panel structural design.

MacPASCO creates input for PASCO (rcfs. I and 2), an existing computer code for structural

analysis and minimum-mass optimization of longitudinally-stiffened composite panels.

MacPASCO's graphical interface simplifies the specification of panel geometry and reduces user

input errors, thlm making modeling and analysis of panel designs more efficient. The user draws

the geometry of a structural panel cross section on the computer screen. Then a combination of

graphic and text inputs is used to refine the structural geometry, to specify information required for

analysis such as panel load conditions, and to define design variables and constraints for minimum-

mass optimization.

I)ASCO u._.'m a linked-plate representation of geometry in which individual flat plates are
a.*_emhlcd to construct a structural panel cross section. Two or more individual plates are

a._embh'd to form a substructure, which is repeated to create the entire panel cross section. A plate

is constructed as a balanced symmetric laminate of a prescribed number of plies with orthotropic

material properties. The two figures below illustrate this modeling technique.

X,u,O

o

The left-hand riga]re above shows a hat-stiffened structural panel and the global panel coordinate

system X, Y, Z. Boundary conditions arc placed on the lateral (X axis) edges of the panel by

constraining the rotation 0 and displacements w, v, u. The fight-hand figure shows a hat-stiffener
substructure whidl is repeated three times to form the cross section of the panel on the left. Six

plates are assembled to form the hat-stiffcncr substructure.
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Structural modcling with MacPASCO follows PASCO's modeling technique. MacPASCO
displays a drawing window in which the user creates a substructure like that shown in the right-hand

figure above. MacPASCO's graphical tools allow the user to manipulate plates on the computer
_recn to create the desired substructure.

This manual is a guide for the use. of MacPASCO, and a reference document which contains

a comprehensive list of all of MacPASCO's features. Some knowledge of the PASCO code is

required to use MacPASCO effectively, since MacPASCO only produces the input for PASCO.

PASCO is used subsequently to actually perform the structural analysis and sizing using the input

MacPASCO generates. The PASCO code is described in references 1 and 2. in addition, a stand-

alone Macintosh version of the PASCO code, which can be used alone or in conjunction with
MacPASCO, is described in reference 3. An earlier version of MacPASCO is described in reference
4.
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The Screen Dis la

Ma(:I)ASCO's interface consists of a drawing window which displays a drawing of a panel cross

section. A tool window contains a palette of graphical tools which are used to create and manipulate

the displayed cross section. A menu bar across the top of the screen allows for other inputs required
for structural panel analysis and sizing. The MacPASCO interface is consistent with the Apple

Macintosh computer interface guidelines for windows, scroll-bars, pull-down menus, dialog boxes,

and other Macintosh interface, features. In this way, MacPASCO shares features common to many

Apple applications.

Macl)ASCO's initial screen display is shown below:

Menu bar

Tool
Palette
Wi ndov

Drawlng
Wi ndow

Tools iI-I_

Plate Information:Vidth : O.'Y.CY"3"_C"

Rotation" ::=.CC'C'CC.','C'C

i

Untitled-I ==_i_mmm_u ,ffi_l=...llm

.01

El rl
fl fl

0

_Bill

g

The drawing window displays a view of the cross section which is repeated to form the stiffened

panel. The displayed cross _ction initially consists of a single fiat plate. The display shows the

boundary conditions on the panel edges. Initially, the panel edges are free as indicated by the

annotation, fl, on the end nodes of the cro_ section.

A message box, labeled "Plate Information: _ displays plate width and rotation as plates are

manipulated on the _recn. In this manual, the term rotation means the orientation of a plate in

the structural geometry. U_ of the term rotation to denote a degree of freedom is explicitly noted

in the text. Messagc box entries are dimmed when inactive, in accordance with Apple Macintosh

computer conventions. The tool palette, window displays small pictures of various tools used to

draw and manipulate the _ction graphically. These tools are described in detail in another section

of this manual.
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The menu bar at the top of the screen displays a range of options, grouped by function. Only
the name of each menu appears; the full menu pldls-down when the u._r points to the menu name

and holds the moIL_ button down. For example, the pull-down view of the Optimization menu

is shown below:

To choose an item from a pulled-down menu, drag the mo_ pointer from the menu name

down to the item and release the molL_. The Optimization menu allows the _r to define the

number of sizing cych_ during optimization and to define linking equations. Menu options are
disca_._,d in detail in another _ction of the manual.
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The Tool Palette

Tools
The tool palette is a floating window containing small pictures, called icons, of various tools. The

palette is a floating win&_w because it always remains in front of any other MaePASCO window so

that the tools are always visible and availabh:. The tool palette can be moved around the screen

like any other window.

The tools arc u.,a:d to draw and manipulate the cross _ction displayed in the drawing window.

Tools are _lected by clicking on the tool's icon with the mouse. The icon for the currently selected

tool is always darkened, indicating which tool has been selected. In addition, when the cursor is
over the MacPASCO drawing window, the cursor usually changes to reflect the currently selected

tool.

There are seven tools available in the current version of MacPASCO: a point-hand tool, a grab-

hand tool tool, an add-node tool, an add-plate tool, an add-loop tool, a magnification tool, and a
delete-node tool. Each tool and its fimction arc discu._ed in the sections that follow.

The Point-hand Tool

The point-hand tool is repre._ented by a point-hand icon, as s_cn on the left. When the point-

hand tool is sel_tcd, the cursor changes to I_x_k like the point-hand icon. This tool has two
flmctions:

* To select plates in the current cro_s section.

• To display a dialog box containing infi)rmation about a plate or node in the current cross
_ction.

[ Selecting Plates]

To _lect a plate with the point-hand tool, place, the index finger part of the cursor over a plate

and click once. The _lected plate darkens to show it has been selected, and previously _leeted

platc..s are de_selectcd. The plate's width and rotation are displayed in the drawing window

m_m_ge box.

To .,adect more than one plate, hold down the keyboard shift-key while clicking on each plate.

Each selected plate darkens to show it h_m been .w.lected. The width and rotation for the most

rc_mtly selected plate appears in the drawing window measage box.

The "Fool Palette 6



• Another way to select a plate or platc_ with the point-hand tool is to press the mouse button

and drag the mouse with the mouse, button depressed. A shimmering rectangle appears on the
screen. When the mouse button is relea._d, plates inside the rectangle are selected, and the

rectangle disappears. A plate must bc completely inside the rectangle to be selected. Once

again, the shift-key can be used to make multiple selections with the shimmering rectangle.

The shift-key mltqt be held down before clicking and dragging the mouse, or previously _lected

plates are de_elccted.

I Displaying Plato InformationJ

To display information about a plate, simply place the index finger part of the cursor over a

plate and double-click. A dialog box appears on the screen displaying information about the plate
such as its width and rotation as shown below:

I'i,ll,' Ill(It IIl<i_lq_t}

Plate Information [] LockPlateGeometry

Width: 20.00000000 [] Oostgn V.rlobi.

Lover Oound Uppur' fieund

t).':';":e:M:":M:":' uO(XXX)()(XXX).,:-:.:-;.:.'u:.:,

Rotation: 0,ooooooooo

Ludmd o: U_leflned

Cancel ]

The plate information display contains the following:

• The plate width which can be edited to a numerically preci_ value.

• A "l)e_ign Variable" check-box which makc_ the plate width an optimization design variable
and allows a lower and upper bound to be prescribed for the plate width during optimization.

• The plate width's lower and upper boun&_ which can be edited when the plate width is an

optimization design variable.

• The plate rotation which (:an he edited t_) a numerically precise value.

The name of the laminate a._')ciated with the plate. The laminate name cannot be changed

with the plate information display and is initially undefined. The laminate is assigned using

the Ansi.gn L_minateo to Plates option of the Laminates menu.

A "l,o'ck Plate Geometry" check-box. When the check-box is selected, the plate width and

rotation are unchanged whcn adjacent plate width and rotation are altered via their Plate

Information dialog boxe.s. ]f "Lock Plate (;eometry" is not selected, the plate, diminsions

change to accommodate changc$ in adjacent plate width and rotation.

l_ch item of the plate infi)rmation display is di_:u_d in sub._luent sections of this manual.

The Tool Palette 7



Modifying Plate Width and Rotation

The plate information dialog box is used to change plate width or rotation. Select the value

to be modified, and type in the new value. The keyboard TAB key can be used to move quickly

from value to value. The mouse can also be u._l to make ._.lections manually, but the TAB key

is usually fs.qtcr than the mouse becai_c it automatically scl_ts each value when switching fields.
To select a value with the mouse, click on the current value and a bar cursor, I , appears. The

value c_m be modified in the usual way, backspacing to delete, typing new text, using the arrow

keys to mow the cursor, and using the mouse to _]cct parts of the value to be replaced or deleted.

I WARNING ]

UnUtled-!

Platelnformation: I I

° °
_1 i$i$iliNiil_lil|HWiliMliliN

The current version of MacPASCO do_ not check to see whether or not the new width and

rotation entered via the Plate Information dialog box mak_ the plate exceed the viewing area

boundari(_. For example, consider a plate at the very top of the _roilable viewing area. Giving

this plate a long width and a rotation of 90 degrees grows the plate beyond the viewing area. This

situation is shown in the figure below:

HR_ UntlUed-I _lZ]ii i

Platelnformation: i 1

Vldtk : 100.000000 II
Rotatin : 90.0000000 nl

J
_i I_l_,idali$|li_TdHlilll_|||||

Them'iO_alplate beforethe dlalo9 A largewi41h, _ a rotatkm
boxis usedto expandthe plate of 90 degreesexpandstheplate
bevo_dthev_wi_ area, beqondthe vlewi_ area.

l"xrors are likely to result. Two steps can be taken to avoid this situation:

1. Use the grab-hand tool to move the scction _) that there is room for plates to grow before

modifying the plate widths and rotations. The grab-hand tool is discussed in the next section
of this mamml.

2. Scale the viewing area properly. The viewing area can be made large enough for most cross

sections by using the proper smle for the viewing area. With the proper scale, the problem of

over-large plate.s can be avoided. Scaling the view area is discu._d in another section of this
document.
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How Changing Plate Dimensions Affects Other Plates

Altering a plate's width or rotation via the Plate Information dialog box does not affect the

width or rotation (geometry) of other plates, if a plate width or rotation is changed via a dialog

box, the final node of the plate moves to accommodate the change, as seen in figure a. below.

Any other plates connected to the final node arc al._ shifted, and the shift propagates through the
cross section (figure b), which insures that the gcome.try of these other plates remains the same.

ihcreaslng

first plate's

the
_idth

the other plates
also shift

Figure a. Figure b.

Exception: An exception occurs when the cross section contains a loop or eyrie, such as the

triangle shape in the figures above, in such a loop, the width of one plate in the loop cannot

change and still hold the widths of the other plates fixed. An error message results. In these cases,

the width of one of the plates in the loop m_t change to accommodate the altered plate. If a

change in a plate's width is attempted without unlocking another plate, in the loop, the following

error message appears:

O Thls plate's width and/or rotation

cannot be adjusted without

altering a rigid plate

The box labeled Lock Plate Geometry in the upper right corner of the Plate Information

dialog box is used for these situations. Clicking in the box unlocks the plate, allowing the plate

to change dimension to accommodate changes to adjacent plates. When a plate is locked, a cross

(X) appears in the h)ck plate check box.

in the example below, the plate forming the right side of the triangle has been unlocked and

the width of the plate forming the left side of the triangle is increased.

When the plate forming the left side of the triangle gets longer, the unlocked plate forming the

right side of the triangle changes dimension to accommodate the change.

The Tool Palette 9



Initially, all plates are locked, so that altering a plate's width or rotation does not affect the

geometry of other plates. The Lock Plate Geometry check-box is used to make one or more

plates flexible, typically for the case of a loop.

Making Plate Width an Optimization Design Variable

The plate information dialog box is also _ed to make the plate width a design variable. The

square labeled "design variable" (in the plate information dialog box shown previously) is a check
box. When a cross, X, appears in the cheek box, the plate, width is a design variable during

optimization. When no cro_ appears, the plate width is not a design variable. If the plate width

is not a design variable, clicking on the check box makes the plate width a design variable. If the

plate width is a design variable, clicking on the check box makes the plate width not be a design

variable. The upper and lower bound fields are disabled when the plate width is not a design
variable.

Displaying Node Information ]

To display information about a node, place the cursor over the node and click once. The

following dialog box appears:

Node ID: [_ Boundary Cohdit_n: [rs[_,,_,_=

-oNode ImCarmatloR jStar* Node (_) Final Node C) Interior Node

{Cancel}

The node information display consists of the following:

• The node number used in the PASCO output is shown but cannot be edited.

• A pop-up menu which displays the current boundary condition on the node, and allows the

boundary conditions on the nodes at the edges of the panel to be changed.

• Thr,_ indicators show whether the node is on a panel edge or in the inte.rior. The node on the

left, edge of the panel is the start node, the node on the right edge is the final node.

Each nod(: is numbered; the node number appears in the upper left-hand corner of the dialog

box. The darkened circle under node. information indicates whether the node is the start node,

final node or intcrior node of the cr(_ section. In the example above, the node is a final node.

Finally, a pop-up menu in the upper right-hand corner of the dialog box specifies the boundary

conditions on a node. Clicking on the menu with the mou_ displays a range of possible boundary

conditions. The start node's boundary conditions apply to the entire left edge of the panel, the

boundary condition on the final node apply to the entire right edge of the panel. Each boundary
condition is discu._d in the next _ction of this manual.
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Boundary Conditions

Clicking on the boundary condition pop-up menu reveals the list of possible boundary

conditions. To select a boundary condition for the panel, click and hold the mouse button down

over the boundary condition pop up menu of the node information dialog box. Keep the mouse

button depressed and drag the mouse over the desired menu choice. Rclease the mouse button

and the boundary condition beneath the mm_._ b_ome_ the new boundary condition foc the panel

edge.

The boundary condition pop-up menu is shown at the left below. A table which describes

the constrain_ implied by each boundary condition appears on the right. The rotation being

constrained is a degree frecwlom at the node.

Boundar 9 Condition

Pop-Up Menu
\

Free (F I )
F2

F3

F4

Simple Support ($S ! )
S52

553

S54

$gmmetrg (S I )
$2

$3

S4

Clamped (C ! )
C2

C3

C4

btbtion )istleeemnt )ispleeeMnt )ispleee_nt

[X-exis] w v u

free free free free

free free free Cons_r_ine4

free free ¢ohstr_ined free

free free Constrline& Cohgtrlihed

free

free

free

free

Constrained

Constrained

CenstrQined

Censtrlined

Cohstrtihed

Constrained

¢onstrQined

Constrlined

Constreined

Cehstr_ined

Constrained

Constrained

free

free

free

free

Cthstrtintd

Constrlined

Censtr_i_td

Constrained

free

fret

Constrained

Cons_rQine4

free

frQQ

Constrii_eK

Constrained

frQe

free

¢ohs_r_ined

Constrained

free

Constrained

free

Constrained

free

Constrained

free

Constrained

free

Constr_ined

free

Censt_l_he4

._X, u, O
Displaoements w, v, u, and rotation O are

relative to the global panel coordinate

sMstem X, Y, Z shown 8_ the lefl.

The table mimmarizing each boundary condition is shown to the right in the figure above. Note that

SS3 is the cl&_sical simple support boundary condition and C3 is the cla.qsical clamped boundary

condition, in MacPASCO, boundary conditions can ONLY be applied at the start or final node,

and the three displacements are relative to the overall panel coordinate system (shown at the

bottom of the figure above), rather than to the local plates.
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The boundary conditions specified at the start and final nodes apply to the entire panel. Thus

to specify a boundary condition on the left-hand edge of the panel shown above, one must select

the start node and specify a boundary condition. Likewise, boundary conditions on the right hand

edge are selected by specifying the correct boundary conditions from the final node's pop-up menu.

The Grab-hand Tool

The grab-hand tool is represented by an open hand icon, as ,seen on the left. When the grab-hand

tool is selected, the cursor changes to an open hand cursor that looks like the open hand icon.

This tool has three fimctions:

• It can be used to select plates in the current cro_s section.

• It can be used to move plates in the current cross section.

• It can be used to change the dimensions of plates in the current crass section.

Selecting Plates ]

Plate selection with the grab-hand tool is identical to plate selection with the point-hand

tool. llowever unlike the point-hand tool, the grab-hand tool can also move a plate or change

its diminsions. Thus when the grab-hand tool is t_d to make selections, it is possible to move

aecidently a plate or change its diminsions. Consequently, the point-hand tool is usually used to

select plates in order to avoid such accidental changes.

Center the palm of the hand cursor over a plate and dick once. (The small cross in the cursor

palm can be used as a guide). The selected plate darkens when selected and any previously

selected plate_ are desclected. The plate's width and rotation are displayed in the drawing

window message box.

qb select more than one plate, hold down the keyboard shift-key while clicking on each plate.

Each selected plate darkens when selected. The width and rotation for the most recently

selected plate appears in the drawing window message box.

Another way to select a plate or plates with the grab-hand tool is to press the mouse button

and drag the mouse with the moose button depressed. A shimmering rectangle appears. When

the mouse button is released, any plates inside the rectangle are selected and the rectangle

disappears. A plate must be completely inside the rectangle to be selected. Ono_ again, the

shift-key can be used to make multiple selections with the shimmering rectangle. The shift-key

must be held down before clicking and dragging the mouse, or all previously selected plates are
deselected.

Moving Plates ]

it is sometimes convenient to move plates, usually to move the current cross section into a more

accessible location in the drawing window. To move one or more plates, do the following:

1. Select the plates to be moved either using the point-hand tool or the grab-hand tool.
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2. Point to a selected plate, press the molme button and drag the mouse with the mouse button

still depressed.

All the selected plates move to follow the movements of the mouse. The widths and rotations of

the selected plates are. not changed by the move. Plates connected to the moving plates change

dimension to accommodate the movement, as seen in the figure below:

C11¢kand

ates to drag the_

Unselected plates stretch
to accomodate the movement

• Noti¢_ that moving plates does not affect connectivity (how the plates are attached to one

another) but can change the width and rotation of plates connected to the moving plates.

Plate movements can be undone immediately after the move by selecting the Undo option of the

Edit menu. Thus if one moves a collection of plates and realizes the movement was a mistake,

one can select "undo" to restore the plates to their original locations. However, the "undo"

action must bc taken before attempting any other actions or switching tools. For example, if

plat_ are moved, and then the point-hand tool is _lected, undoing the movement is no longer

possible.

I Changing Plato Dimensions]

The grab-hand tool can be used to change plate dimensions by grabbing and dragging nodes.

To change a plate's dimensions:

Point to a node, press the mouse button and drag the mouse while keeping the mouse button

pressed. All plates attached to the node change dimensions to follow the node's movement.

For example, consider the figure below:

Click and dra_
the node

• The drawing window message box displays the width and rotation of the plate being altered.

If one or more plates are being altered, the width and rotation of the most recently selected

plate is displayed.

* The option-key on the keyboard allows a plate's width to be changed without altering its

rotation. To alter only plate width, hold the option-key down when clicking on the node with

the grab-hand tool before dragging the node.

As with moving plates, plate dimension changes can be undone immediately afterwards by

selecting the Undo opti(m of the Edit menu. The "undo" action must be taken before attempting

any other actions or changing tools. Fbr example, if a node is moved to change plate dimensions,

and then the point-hand tool is selected, undoing the movement is not possible.
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The Add-node Tool

The add-node tool is represented by the icon shown at the left. The add-node tool is used to add

a node to an e_cisting plate, essentially splitting a single plate into two plates sharing a common
node. When the add-node tool is selected, the cursor changes into a cross-hair cursor that looks

like a large "plus" sign.

• To add a node to a plate, do the following: place the intersection of the cross-hair cursor over a

plate and pre_ the mouse button. A node is added to the plate at the cursor. Adding a node
forms two new plates, one which ends with the new node and one which starts with the new

node as seen in the figure below:

Addednode Drag oursor ._

CHok to add a node _, to adjust .,_1.....
o o a.............................o o,"'"

Plate ending at Plate starting at
new node nev node

By dragging the mourn with mouse, button depressed, one can move the new node as it is

added, as shown above. The drawing window me_sage box displays the width and rotation for
the plate which ends with the new node.

• it is often usefill to add a node to a plate and produce, two new plates with the same rotations

as the original plate. To do this, hold the Option key on the keyboard down while clicking on
the plate to add a node. Dragging the mouse with the mouse button depressed moves the new

nod(:, but thc rotations of the new plate_ are fixed, as _cn below:

rh, opts-keyho s
the rotatior_ fixed _ I

The user adds a nod(; to a plate with the keyboard's option-key depressed, as seen in the figure on
the left. As the u._r drags the mouse upwards the node moves, but the rotations of the two new

plates are held fixed, as seen in the figure on the right.

The addition of a node can be undone immediately afterwards by selecting the Undo option of

the Edit menu. The "undo" action must be taken before attempting any other actions or switching

tools. For example, if a node is added to a plate, and then the point-hand tool is selected, undoing
the add is no longer possible. The current version of MacPASCO does not allow deletion of a node

or plate, once it has been added to the cro_ section.

The Add-plate Tool,i

The add-plate tool is represented by the icon shown on the left. When the add-plate tool is selected,

the cursor changes into a cross-hair cursor, which looks like a large "plus sign." The add-plate tool

is used to add new plates to a node in an existing cro_s section.
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dr•_/• plate
bet,_een these two nodes

To add a new plate, move the cursor over a node, press and hold the mouse button, and drag
the mouse with the mouse button depre_ed. As the cursor moves, a new plate appears between

the original node and the current cursor position. For convenience., the drawing window message

box displays the width and rotation of the new plate. When the mouse button is released, the new

plate is added.

The final node of the added plate is always unconnected and not attached to any other existing

plates. Thus, two disconnected nodes cannot be joined by drawing a plate between them, as shown
below:

these t_vo nodes are

not attached; one node is

simp_ superimposed over

A. B. C.
To make the cross _ction shown in figure C. above, but with all the nodes attached, the add-loop

tool is required. The add-loop tool is disams._d in a subsequent section of this manual

The addition of a new plate, can be undone immediately afterwards by selecting the Undo

option of the Edit menu. The "undo" action mlmt be taken before attempting any other actions

or switching tools. For example, if new plate is added, and then the point-hand tool is selected,

undoing the addition of the plate is no longer possible.

Plates can be deleted from the cross _ction using the delete-node tool described subsequently
in this manual.

The Add-loop Tool

The add-loop tool is represented by the icon image which appears on the left. When the add-loop

tool is selected, the cursor changes into a cro.ss-hair cursor, which looks like a large "plus sign."

The add-loop tool is u._d to create a closed section between two nodes on the existing cross section.

To add a loop, move the cur._r over a plate and click the moo._ button.

compo_d of two new plates appears, as shown in the figure below:

Click to create,.%, _
fk a closed section _

A dosed section

The closed section is composed of two plates. The other palette tools can be used to create

closed sections or thr(.v, or more, plates from this initial cross section, by adding more nodes and

manipulating the plates that are created.

The addition of a cltx_d-_ction can be undone immediately afterwards by selecting the Undo

option of the Edit menu. The _mdo" action must be taken before attempting any other actions or
switching tools. For example, if a loop is added, and then the point-hand tool is selected, undoing

the creation of the cl(x_d _ction is no longer possible.

CIo,_._i sections can be deleted from the crc_s section using the delete-node tool discussed in a

subsequent section of this manual.
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How Closed Soctlons carry Transverse Loads]

Plate_ in closed sections created with the add-loop tool do not carry transverse loads. The

situation is illustrated in the figure below:

Pressure

Closed se©fl4m oroated with

add-loop tool.

3 dirnenslc_al view of the

p_el for the cross-section on the kfft.

The sides of the trlangulu" sttffe4_r oarru no

trmsvorse Io_ds (NxU _1 NU).

The cloud section in the h:ftmost figure was created Lining the add-loop tool. The user clicked on

plate e to create a elosed-seetion formed by platc_ a and b. The rightmost figure shows a view
of the entire panel reprc.sented by the MacPASCO drawing on the left. The transverse loads are

Ny, which is transverse tension or compression, and Nxy, which is a shear load. The Ny load is

entirely carried by plate c. The new plates, a and b, do not carry any Ny load. The Nxy load
is distributed aecx)rding to the stifrne._ of the sheer paths. _ references ] (p. 37-38) and 2 for
details.

The Magnifying Glass Tool
I

The magnifying gla._s tool is represented by the icon shown on the left. When the magnifying

gla.qs tool is selected, the cursor change_ into a magnifying gla._ cursor that looks just like the
magnifying glass icon. The magnifying gla._ tool is u.sed to "zoom" in or out on the current cross
section.

Four levels of Magnification are available. The initial screen display is at the minimum level of

magnification: one cannot zoom-out any further. Each magnification level 7x)oms in by a factor of
2 larger than the previous level.

Zooming in mak{._ the current crn._s ._.,ction appear larger on the _recn and allows for more

preci_ direct manipulations of the plate_. For example, zooming in once magnifies the current

cross _ction so it appears twice as large, i,ikewi._., zooming out allows a smaller view but less
control.

• I_) zoom in, place the cursor in the viewing area displaying the current cro_ section and click.

The view "zoorns-in," centered on the cursor positkm at the time the mouse button was pres._d.

• To zoom out, place the cursor in the viewing area displaying the current cross section, hold
down the keyboard's option-key and, at the same time, press the mou.qe button. The view

"zoom_out," centered on the cursor position at the time the mouse button was pressed.

Zooming in and out with the magnifying tool has no effect on plate width or rotation. Only

the screen display of the plate_ is changed.
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The Delete-node Tool

The delete-node tool is represented by the scissors icon shown at the left. The delete-node tool is

used to delete nodes, and consequently plates, from the existing cross section. A plate is deleted
when its end node is deleted. When the delete-node tool is selected, the cursor changes into a

cross-hair cursor that looks like a large "plus" sign.

• lb delete a plate in a chain of plates, do the following: place the intersection of the cross-hair

cursor over the end node of the plate and press the mouse button as shown below:

These two plates are This plate is
deleted ...... added

/
o _ v----v .......... ............o-----o o

A. B. C.

In this case, the delete-node tool acts as the inverse of the add-node tool.

* 'lb delete a plate on tilt; end of a chain of plates, do the following: place the intersection of the

cros_-hair cursor over the end node of the plate and press the mouse button, as shown below:

_ "# _v.---.-.o.---o

A. B,

In this case, the delete-node tool acts as the inverse of the add-plate tool.

• To delete the two plat_m that form a closed section, do the following: place the intersection of
thc cro._._-hair cursor over thc shared node between the two plates and press the mouse button,

as shown below:

A.

In this case, the delete-node tool acts as the inverse of the add-loop tool.

B.

The deletion of a node and associated plates can be undone immediately afterwards by selecting

the Undo option of the Edit menu. The "undo" action must be taken before attempting any other

actions or switching tools. For example, if a node is deleted, and then the point-hand tool is

selccted, undoing the node deletion is no longer possible.
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The File ] lenu
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Page letup._
Print be

Print...

Quit mO

The File menu, shown at the left, contains all of MacPASCO's commands for opening and closing
files. To display the File menu options, move the cursor over the word "File" in the menu bar,
then press and hold the mouse button.

Selecting Menu Options
I

qb _lect a menu option, move the mouse over the word "File" in the menu bar then pre_ and hold

the rnou_ button Ix) display the File menu options. Next, with the mouse button still depressed,

move the mouse, over the menu option desired. As the mou_ moves over each option, the option

darkcns in the display. Once thc desired option is darkened, release the mouse, button, and that
option is ,_.lccted.

File Dialog Boxes

When opening or saving a file, Ma_:PASCO displays a dialog box to prompt for the name of the

file Ix) be opened or saved. All file dialog boxes follow the same conventions. Sample file dialog

boxes for opening files and for saving files appear below:

0 File 2
C:)Folder I
(2) Folder 1
r_ Folder 3

Open FHeDialogBox

[ [ll'tpe ]

[ Open J

{ Cancel]

(_ £xemples_]

ri, I  SCSlOO

flip.2 [ tJecl ]Folder I

Folder2 [ Dllve "J
Folder 3

Save this document as: [ Save ]

[ Cancel ]

Save File DialogBox

A file dialog box contains a scrollable list of files and folders as shown above. The list only displays

the contents of a single folder or disk at a time. The name of the current folder or disk appears
above the scrollable list. To open or ._ve a filc in another folder, make that folder the current

folder. There are two ways to change the current folder:

l. I)ouble-clicking on a folder displayed in the list makes that folder the new current folder and

displays its contents in the scrollable list. Al_rnatively, clicking on a folder in the list to select
it, and then clicking on the Open button also makes the _lectcd folder the new current folder.
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2. The current folder name above the list is actually a pop-up menu. Clicking on the current

folder name and keeping the mouse button down displays the location of the current folder on

the disk. The current folder appears at the top of the list, followed by the folder that contains

the current folder, and so on with the disk that contains all the folders at the bottom of the

list. Drag the mouse to a folder or disk in this list and release the mouse button. That folder
or disk becomes the current folder.

Switching Disks [

The Drive button to the right of the scrolling file list switche_ disks. Clicking on the Drive

button cycles through the hard disks and floppy drives connected to the computer. To open or
save a file on a floppy disk, insert the disk into the disk drive and click on the drive button. The

Eject button ejecks a floppy disk so that another disk can be inserted. The disk icon above the

Drive button displays the current disk.

[ Cancel ]

Clicking on the Cancel button cancels the attempt to open or save a file without any files

being opened or saved.

New
I

Select Now to begin the specification of a new panel. The Now menu option creates a new

window containing an initial panel cross _ction, which is a single unstiffened plate with free

boundary conditions at both edges, as shown below:

I_ Untitled- I 'd

lele Informetlon:

The tool palette and other menu options are u._;d to complete the specification of the panel.

Open

Select the Open menu option to continue work on a previous panel design that was previously

saved as a file. When Open ks seleetcd, a file dialog box appears .so the user can interactively

select the file to be opened.
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I Selecting and Opening a File]

The file dialog box contains a scrollable list of file_ and folder. The list only displays files or

folders which might contain a panel design, so only folders and MacPASCO files appear in the list.

For example, text files do not appear in the list. To open a file, either double-click twice on the

filename displayed in the list, or click once on the filenamc and then click on the open button.

Finding the File to Open[

The list only displays the contents of a single folder at a time. The name of the current folder

appears above the ._rollable list. If the file t() be opened is in another folder, make that folder the

current folder so the file appears in the list. Once in the list, the file can be selected and opened.

The previous File Dialog Boxes _ction of this manual de_ribes how to change the current folder
to another folder or disk.

Make PASCO Code
I

The Make PASCO Code option allows the u._.r to generate, a text file of PASCO input for the

panel displayed in the front-most window. When this option is selected, the following file dialog

box appears to prompt for the name of t,t,_ PASCO input file:

_ Examples ]

[_'1 file I [] "--'SCSl80

WCI flit _ 2

C::) folder l L t'Jra:t J

r_ Folder 2 ( [h'iPO ]
C:::)folder 3

Seue this document as: { $euo }

{ Cancel }Ilhtltl*_ I _'. "!I

The Make PASCO Code file dialog box is the same as the standard file dialog box discussed in

the previous File Dialog Boxes section of this manual. Type the name of the file, then click on

the save button and MacPASCO generate_ the PASCO input and saves it in the file.

IThe Generated PASCO Input I

PASCO's input format is described in reference l. The PASCO input generated by MacPASCO

is an ASCII file which can be used without modification &_ input to PASCO. The advanced user

can modify the generated PASCO input with a text editor to add additional inputs which are not

generated by this version of MacPASCO.
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Close

Select the Close menu option to stop work on the panel design displayed in the frontmest
window and close the window. The same effect is achieved by moving the mouse over the box in

the upper left-hand corner of the window and clicking the mop_. If modifications to the panel

displayed in the frontmost window have not been saved in a file, the following dialog box appears:

Save changes to "Untitled-l" before
¢1o$ing7

Yes

[ No ] [ Cancel ]

• The message contains the name of the current frontmost window. The dialog above shows
"Untitled-l" as the frontmost window name.

• Click on the Yes button or type the return key from the keyboard to save the modifications in
a file.

• Click on the No button to clese the frontmost window without saving modifications in a file.

• Click on the Cancel button and the frontmost window is not closed.

Save

The Save menu option saves the panel design displayed in the frontmost window as a file. The

first time a save occurs, MacPASCO prompts for the file name with the standard save file dialog

box. Jl_st type the name for the file and click on the save button. The previous File Dialog
Boxes section of this manual describes how to use the save file dialog box in detail.

Once the panel design has been saved in a file the first time, each subsequent use of the Save

menu option saves the panel design in the same file; no additional prompts for the file name appear,
and the contents of the file from the previous Save are overwritten. The Save As... and Save a

Copy In... options allow saving into different files.

Save As...

The Save As... menu option saves the panel design displayed in the frontmost window as a

file. The Save As... option is identical to the Save option, except that the Save As... option

always prompts for a file name where&q the Save option only prompts the first time a save occurs.
The Save As... option allows the user to save. a copy of a panel design in ancw file and continue

working on the copy.
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Save a Copy In...

The Save a Copy In... menu option save_ the panel design displayed in the frontmost window

in a file. A file dialog box appears to prompt for the file name. The previous File Dialog Boxes

section of this manual describes in detail how to use the save file dialog box.

Save a Copy In... saves a copy of the original panc] design and the user continues working on

the original Save as... _ves a copy of the original panel design and the user continues working

on the copy. Thus, Save a Copy In... is useful for _ving a panel design in various stages of

development.

Page Setup...

Select the Page Setup... menu option to change the way pages are printed. For example, pages

can be printed horizontally (i.e., with the longest side on the bottom and top of the page) rather
than vertically.

This option displays the standard Apple Macintosh page setup dialog box as displayed below:

ii

LaserWriter Po_e Setup s.o.z
Paper:. • USLoiter 0 R4 Loiter

Ous Legal 005Letter 0[ Tabloid ]

Reduce or J'_-----']% Printer Effecls:
Enlarge: _i_ [] Font SubslituUon?
Orientation [] Text Smoothing?

[] Graphics Smoothing?
[] Foster Bltmap Printing?

The _ttings chosen using the Page Setup... options are u_d by both the Print... and Print

One options.

Print One... and Print...

[ Print... i

Print... prints the drawing of the panel geometry that appears in the frontmost window. The

Print... option displays the standard Apple Macintosh dialog box shown below:

LaserWrllor "SharonWrlter II = s.0.z

Pages: ® All 0 From: [_] To: ['----_

Cover Page: ® No 0 First Page 0 Last Page
Paper Source: 0 Paper Cassette 0 Manual Feed

Print: • Color/Groyscalo0 Black& White

Usually the panel gcom('try drawing fits on a single sheet of paper turned horizontally using the

Page Setup menu option. If the drawing doe_ not fit on a single sheet of paper, MacPASCO prints
multiple sheets of paper such that each sh_t contains a section of the panel geometry drawing.
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[Print OneJ

Like Print, Print One prints the drawing of the panel geometry displayed in the frontmost

window. However unlike Print..., Print One does not display the Apple dialog box, and only

prints one sheet of paper. If the drawing does not fit on a single sheet, only that part of the

drawing that fits on one sheet of paper is printed.

Quit
I

The Quit option ends the session with MacPASCO. All the windows are closed. If any panel

designs contained in the windows have bccn modified but not saved, the user is warned with the

dialog box described in the Close menu option section of this manual. The dialog box gives the

ttser an opportunity to ave panel designs before quitting. Click on thc button labeled Yes to save

the pancl design, click on the No button to avoid saving thc panel design. The Cancel button

keeps MacPASCO from quitting and allows the MacPASCO ._,sion to continue.

The FileMenu _3



I I I I

The Edit Menu
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The Edit menu contains MacPASCO menu commands: Undo, Cut, Copy, Paste, Clear, and

Show Clipboard. The current version of MacPASCO does not use the commands Cut, Copy,

Paste, or Clear. These commands are dimmed in the MacPASCO Edit menu. However, the

Apple Macintosh interface guidelines require that these commands appear in the Edit menu for

u,_, by Apple desk accessories.

Undo

The Undo menu option reverses the previous command. For example if you accidentally add
a node to the panel geometry, Undo remowm the node and re-stores the panel geometry to its

previous state. The Undo command allows you to change your mind and undo an action.

After undoing an action, the menu option title becomes R_o xxx, where xxx is the command

that was undone. If you choose Redo xxx, the undo command is cancelled. For example, if you

add a node to a panel geometry and choose Undo, the node is removed. If you now choose Redo,

the nod(: is added to the geometry again, and the menu option title becomes Undo in ease you
change your mind again.

[Can't Undo]

Some actions cannot bc undone, if the previous command cannot be undone, the option Can't

Undo xxx replaces Undo. The xxx is the name of the command that cannot be undone.

Show Clipboard
I I

The clipboard is the standard Apple Macintosh name for a buffer which contains graphics and text

that has been cut or copied with the Cut or Copy menu c_mmands. The Show Clipboard menu

option displays the clipboard window to show the most rccently cut or copied text or graphics,

and the menu option title be_.omcs Hide Clipboard. Since MacPASCO currently does not use

cut or copy this option is not particularly u.,_.ful at pre_nt.
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The View Menu
I
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The View Menu contains the following menu options that change the MacPASCO drawing window:

the Zoom In and Zoom Out options which magnify the drawing view like the magnifying glass

tool from the floating tool palette; the Scale Current View option which changes how screen

coordinates correspond to actual coordinates without changing the display; and the Show Plate

Numbers option which causes each plate clement in the drawing window to display its numeric

identifier. Each of thc,,m,options is discussed in the sections that follow.

Zoom In and Zoom Out

The Zoom In and Zoom Out options magnify the view in the front MacPASCO drawing

window. 7morning in makes the current panel erc_s _,_ction appear larger on the screen and allows

for more precise dircet manipulations of the plates in the model.

Four levels of magnification are available. The initial screen display is at the minimum level of

magnification: one cannot zoom out any further. F_ach magnification level zooms in by a factor

of 2. The Zoom In and Zoom Out options are nearly identical to the tool palette's magnifying
glass tool.

• Zoom In magnifies the view by a factor of 2 and centers the new view in the drawing window.

• Zoom Out magnifies the view by a factor of ½ and centers the new view in the drawing
window.

• The difference, between these menu options and the magnifying gl&_s tool is that the tool uses

the cursor pcxsition to center the new view and the menu options do not.

Zooming in and out has no effect on the widths and rotations of the plates forming the current
cross _ction; only the screen display is altered.

Scale Current View
I

The Scale Current View option changes how screen coordinates correspond to actual

coordinate_. This option is generally u,_d once to scale the current view before drawing the

panel cross section.
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Select a convenient scale to make drawing and viewing the cross section easier. For example,

if the plates forming the panel cross section range in width from 0.1 units to 0.3 units, scaling can

be used to specify that one inch on the screen corresponds to 0.1 units. Thus the screen display

of a plate 0.3 units wide is 3 inches wide. Alternatively, if the plates in the cress section range
in width from 10 units to 30 units in width, scaling can be used to specify that one inch on the

screen corresponds with 10 units so that the screen display of a plate 30 units wide is 3 inches.

The following dialog box appears when the Scale Current View is selected:

%1 ,)tlli

• o = I 0.00000

Uamthe dtsplat/above to Kale vour models. The

display altars hey the v4ewll display ore plate
ralatsc to the plltl'l vtdih.

Te theme the scala, Jwt enter a IWV vldth w e
number betvscn 0.001 IM tO00.

! OK I [ Cancel )

The plate element on the left shows how the screen image corresponds to the actual distance shown

on the right. For the figure above, a plate the siT_ shown in the dialog box is 10 units in width.

IThe Difference Between Scaling and Zooming]

The magnifying glass tool and the two Zoom menu options are used to zoom in or out. They

only magnify the screen display, the actual dimensions of the panel cro_ section do not change. In

contrast, scaling changes the dimensions of the panel cross section to accommodate the new scale,

but the screen display does not change.

Show Plate Numbers
I I

The Show Plate Numbers menu option displays unique identification numbers with each

plate displayed in the front MacPASCO drawing window. When the Show Plate Numbers

option is _lected, the plate identification numbers appear and the menu option wording changes

to Hide Plate Numbers. These plate numbers are i_d to form the PASCO variable B() in the
namelist PANEL.

The plate numbers have two purposes:

1. Plate numbers are uscflfi for understanding PASCO's output since many output quantities are

given in terms of plato number.

2. Plate numbers are u._',d when defining linking equations, as described in the section on the

Optimization menu options.
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The Panel Menu
I I

m

I bptl PMe0toQa [ The Panel menu contains MacPASCO options that affect the entire panel. Panel
I1111enllalme° l
l+um_orofllopoollnlltlOmeelo menu options are used to define the total panel length, to define panel loading
_uJ tsltm Psnol conditions, to specify the number of stiffeners along the panel width, to specify

buckling mode half-wavelengths for which buckling loads are examined, and to view the entire panel cross

section (as opposed to the cross section of a single stiffener or repeating substructure shown in MacPASCO's

drawing window).

Apply Panel Loads

The Apply Panel Loads menu option is used to define the total panel length and the panel

loading conditions. Selecting this option displays the following dialog box:

I',_lnl't i)+l++_

o.ooo0ooooo
ioo0ooooooo u\" - I°'°°°°°°°°° I

O.OOO000000 J

{ Cancel }

In the dialog box above, the entire panel is represented by the quadrilateral figure in the center of

the display, with the panel length indicated along the sides of the panel. Possible input values are

labeled in the figure.

• qb change a value, pre_ the tab key until the value to be changed is highlighted, then type the

new value using the keyboard. Alternatively, move the cursor over the desired value with the

mou._, and click. A bar, I, cursor appears and a new value can be typed. It is usually faster

and easier to IL_e the tab key.
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• Move the cursor over the OK button and click to close the dialog box.

• Move the cursor over the Cancel button and click to dose the dialog and cancel any changes

that were specified. Changes to the panel length or panel loads are ignored, and the original
values are restored.

Descriptions of each input parameter appear below. Any quoted text is excerpted from reference

1 and page numbers in reference 1 appear parenthetically after the quote.

Panel Length I

Panel length is the length of the panel. This value corresponds to the PASCO input variable
EL in namelist PANEL.

Mx is the "applied bending moment per unit width." This parameter "should be used when
loading is primarily bending and it is desired to have bending forces used in the calculation of the

A = El, buckling mode," where EL is the panel length. "Bending forces caused by Mx are not

influenced by inplane loads" (ref. I, p. 51). Mx corresponds to the PASCO input variable 14X(t)
in namelist PANEL.

Nx is the "applied inplane longitudinal load per unit width of panel" (inf. 1, p. 52). Nx

corresponds to the PASCO input variable Nx(t) in namelist PAIfEL, and is positive in compression.

Nxy is the "applied inplane shear load per unit width of panel" (ref. I, p. 52). Nxy corresponds

to the PASCO input variable Nxy(t) in namclist in PANEL.

Ny is the "applied inplane trans_rsc load per unit width of panel" (ref. I, p. 52). Ny

corresponds to the PASCO input variable Ny(t) in namelist PANEL, and is positive in compression.

[Pressure ]

l'r_sure is the "uniform lateral pressure loading" (ref. 1, p. 52). Pressure corresponds to the
PASCO input variable Press (1) in namelist PANEL.
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Eigenvalues

The Eigenvalues menu option is used to specify the cigenvector half-wavelengths, _, for which

buckling or frequency eigenvalues ate calculated. Selecting the Eigenvalues option displays the

following dialog box:

IqPllLl,jltJt.'_

Smill_ holf-wlvele_l_h
.. _ u,.k_,q_ ;,. 1_o.oooooooo J
are exandned

I oK n f co. ,l )

PASCO uses the value or A to calculate certain eigenvalues by default. If a desired cigenvalue is not

calculated by default, the dialog box is used to specify specific wavelengths for which eigenvalues

are calculated. Both ,_ and specific eigenvalue inputs are described in the two sections that follow.

• Clicking on the OK button closes the dialog box.

• Clicking on the Cancel button closes the dialog box without saving any changes made to A or

specific eigenvalucs.

Lambda, A, is the smallest half-wavelength for which buckling loads are examined. Lambda is

1reed to derive the PASCO input variable HIh%AHin namelist PANEL using the following formula"

minlarn = panel length
A

Since. KINL/_ must be an integer, the real number result of panet ten0th is truncated.
A

Specific Eigenvalucs ]

The Eigenvalucs dialog box is u._d to enter a number of specific eigenvalues.

PASCO only cal_n_lat_ _rtain eigenvalues according to the. following logic:

l_igenvalues arc calculated for each lambda, A, in the following series:

panel length panel length panel length
1 ' 2 ""' minlam

By default
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The value ,,r _anel _th in the previous series, is determined by user input for A using the

formula:

mirdam = panel lengLh
A

Additional specific eigenvalues not calculated in PASCO by default can be specified in the

matrix shown in the Eigenvalues dialog box. Values should be entered row by row from top to
bottom in the matrix.

• Each entry should bc an integer value, H. PASCO uses the integer value to calculate an
panel le_Lh

associated A value by the equation: lambda = M

• Zero entries in the matrix will be ignored.

The matrix which appears in the Eigenvalues dialog box represents the PASCO input variable
NLAH() in the namelist P__.L.

Number of Repeating Elements

The substructure displayed in the MacPASCO drawing window is repeated one or more times

to form the width of the panel. The Number of Repeating Elements menu option is used to

specify how many times to repeat the substructure displayed in the MacPASCO drawing window.

When the Number of Repeating Elements menu option is selected,the following display

prompts for input:

|lq_llt'dt_ll*] h'tlii'fi_

Ropeet Jhe current ¢rcos-Nctien

r_-_-i timm to brm the
Poml Cr_-NCfl0n. The whole

lionel con be t4en vlth the "Shov
(afire Penel" menu ¢emmencl,

[ c..c., ]

• Type the desired number of repeating elements using the keyboard.

• Click on the OK button to close, the dialog.

• Click on the Cancel button to close the dialog and cancel any changes to the number of

repc.ating elemenLs.

The effect of the Number of Repeating Elements menu option can be displayed on screen

with the Show Entire Panel menu option described in the next section of this manual.

The Number of Repeating Elements menu option corresponds to the PASCO inputs NOBAY
and ICREP in the namclist PANEL.
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Show Entire Panel

The Show Entire Panel menu option displays a new window which shows the cross section

of the entire panel. The entire panel's cross section is formed by repeating the stiffener displayed
in the MacPASCO drawing window. The number of repetitions is specified by the Number of

rtepcRting Elements menu option.

For example, the figure below shows the Show Entire Panel window for a blade stiffener

when the Number of Repeating Elements is three. The blade stiffener display in MacPASCO's

drawing window is shown on the left, and the window displayed by the Show Entire Panel menu

option appears on the right.

i[_ Untltled-I
I

IPlate InformeUon: J
I

R

il" Ponel Uletu ,

-i i-]"

• To close the Show Entire Panel window, move the mouse over the small open box in the
upper left-hand corner of the window and click once.
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The Laminate Menu options define material property information for the plate elements

u_d to construct the panel cross section displayed in the MacPASCO drawing window.

Each plate is a symmetric laminate which consists of layered plies of material. The term
laminate means the same as the term wall used in references 1 and 2. The Laminate

Menu is u_d to define the properties of the materials used to form plies, the thickness and

angle of the plies them_lves, and the ply layups which are used to form each laminate. Finally, the

Laminate Menu is treed to assign defined laminates to plate elements, thus associating msterial

properties with the geometry.

Since the laminates, plies and material properties are geometry independent, and are often
used in different panel cross sections, the Laminate Menu is used to save laminates, plies, and

material properties in a _parate laminate file. The Laminate Menu can also open existing
laminate files. Thus, laminate files can be u._,t to create a database of laminate information for

later u._;, avoiding the redefinition of laminates, plies and material properties.

Define Ply Materials

The Define Ply Materials menu option is used to create a new material, modify an existing
material or delete an existing material. To define a material, the user must input the moduli,

Poisson's ratio, c_eflicients of thermal expansion and other quantities. Once a material has been

defined in this way, the material can be used to form the plies that are layered to form laminates.

When the Define Ply Materials menu option is selected, the following dialog box appears:

Melerlel Information

A list of defined materials appears on the left side of the dialog box. The materials are displayed

alphabetically, with uppere&_e letters precceding lowercase, letters.

• To select a material, move the mouse over the material's name in the alphabetical list and click
the mouse button. The material name darkens to indicate _lection.
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, To create a new material and add it to the database, click on the button labeled Add.

s To modify an existing material, select the material's name in the alphabetical list and click on

the button labeled Modify.

, To &:lete an existing material from the database., select the material's name in the alphabetical
list and click on the button labeled Delete.

Creating and Modifying Ply Materials]

Selecting the add or modify options of the ply material information dialog box described

previolL_ly results in the following display:

MaterltlHum I

[' I'°°°°°°°,° I*""' [0.3
[z 11o000oo0o I,,r*, IO.O
.z 13,oooo.o I ,,f,z [o.o
..o !o., I

Material Failure Criterion and Allowables

Criterion:[ Stress J

o'Lcompression150000.0

ul te_ton 1-50000.0 J

02 comprn_lonL50000.O J

02 tenclen I- 50000.0 ]

,lz g_,r i4oooo.o l

): I"., ,,l_r IOOOO0.nOOOOOOCJ_

., H.

The display shows the current values of ply material attributes, such as Young's modulus and

Poisson's ratio. Enter the desired values by _lecting a value with the mouse and typing a value

from th(: keyboard. Alternatively, pressing the tab key on the keyboard switches to the next input
value.

• The material name must be unique, and can be any text chosen by the user. Attempts to give

two different materials the same name catmes a warning message to appear.

s E1 represents the Young's modulus in the longitudinal (one) direction.

• E2 repre_sents the Young's modulus in the transverse (two) direction.

• E12 repre_.nks the shear moduhLs for inplane shear (plane of the one-two directions).

• IU IO represents the rn&_s density of the material.
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• ANUI represents Poisson's ratio for the material.

• ALFA1 represents the longitudinal coefficient of thermal e_xpansion.

, AI,FA2 represents the transverse coefficient of thermal expansion.

[Material Failure Criteria and Allowables]

The current material failure criterion is displayed using the pop-up menu labeled Criterion in

the ply material display. Moving the cursor over Criterion and pressing the mouse button "pops

-up" a menu of three, possible failure criteria: Strain, Stress, and Tsai-Wu as shown below:

i_ _Stres$

Strain

Tsai-Wu

Move the mouse up or down (with the mouse button depressed) in the pop-up menu to select a
failure criterion. The _]ected criterion darkens. When the mouse, button is released, the selected

criterion becomes the failure criterion for the material.

The allowables for the failure criterion appear beneath the criterion in the ply material display.

The allowables for each criterion are given by the following table:

Stress Strain Tsai-Wu

o l long. comp. stress

o I long. ten. stress

o 2 trans, comp. stro_

o2 trans, ten. stress

-rl2 max shear stress

(el - o; AT) long. comp. strain

(et -oIAT) long. ten. strain

(e2- o2AT)trans, comp. strain

(e2- o2AT) trans, ten. strain
q'12 max shear strain

ol long.comp. stress

Ol long.ten. stress

o2 trans,comp. stress

02 trans,ten. stress

1"12max shearstress

F12

The abbreviations long., trans., comp. and ten. mean longitudinal, transverse, compression, and

tension, respectively. The allowable stresses and strains are entered as positive for compression

and negative for tenskm. FI2 is a quantity in the Tsal-Wu material strength criterion (see eq.

(49), rcf. 1).

Define Plies

The Define Plies menu option is used to create a new ply, modify an existing ply or delete

an existing ply. To define a ply, the user mlLst input the ply thickness, ply angle, and select the
material which forms the ply. Defined plies are. used to form laminates.
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When the Define Plies menu option is selected, the following dialog box appears:

)ly 2

i i

PIU Information

FModlfy

( Delete

] Add snetllemloklst

) _.ym,sdQoted lain.

A list of defined plies appears on the left side of the dialog box. The plies are displayed

alphal>etically.

• To select a ply, move the cursor over the ply's name in the alphabetical list and click the mouse

button. The ply name darkens to indicate selection.

• To create a new ply and add it to the databa._, click on the button labeled Add.

• 'lb modify an existing ply, select the ply's name in the alphabetical list and click on the button

labeled Modify.

• To delete an existing ply from the databa_m+,, select the ply's name in the alphabetical list and
click on the button labeled Delete.

[ Creating and Modifying Plies I

Selecting the add or modify options of the ply information dialog box described previously

results in the following display:

PIO NOlle: I

&Ilia: lO.O00000000

l.ew®r Oeumd

1+.+r_+O+r.++r_++ l

TMckmu: 10.000000000
Lever OevN

f) ,.aO;._t)Our._o I

Material

Pbtelr Jb| _J

o lmJdmm

I
I

i

I I-1 I)eltgnYlrloble
VPi_r l_liNl

lo°°°o°o°o I

I [] l)eslgnVtritble
UIIl_r Boeld

p:oooooooo I

Tollperelore

lo.oooooooo ]

L eedt'+_t.s e Nvlnber

 rrn
I OONt I
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The display shows the current values of ply attributes, such as ply thickness and ply angle. Enter

the desired values by selecting a value with the cursor and by typing a value from the keyboard.

Alternatively, pressing the tab key on the keyboard switches to the next input value.

• The ply name must be unique, and can be any text chosen by the user. Attempts to give two
different plies the same name causes a warning message to appear.

Ply angles are. given in degrees by a p_sitivc number between 0 and 360. Although the ply

angle is defined as positive, the ply angle can be made negative within a stacking sequence for

a laminate when the laminate is defined using the Define Laminates menu option, discussed
in a subsequent section of this manual.

• Ply thickness must be a positive number.

Ply angles and thickness_ can be design variables during optimization. The check boxes labeled

design variable indicate that the ply angle or thickness respectively are design variables. When

a cross, X, appears in the check box, the ply angle or thickness is a design variable during
optimization. When no cr(xqs appears, the ply angle or thickness is not a design variable. If the

ply angle or thickness is not a design variable, clicking on the check box makes the ply angle

or thiekne_ a design variable. If the ply angle or thickness is a design variable, clicking on

the check box makes the ply angle or thicknesq not be a design variable. The upper and lower
bound fields arc disabled when the ply angle or thickness is not a design variable.

• A list in the lower-left of the display lists the currently defined materials by name. One of these

materials must be selected for the ply. The material is selected by clicking on the material
name in the list. The selected material is darkened.

• The value of temperature is the change in temperature for the ply.

• In the current version of MacPASCO, only values for a single Ioadcase can be entered. Hence,
the Ioadcasc number display is dimmed and cannot be changed.

Define Laminates

The Define Laminates menu option is used to create a new laminate layup, to modify an

exi_ing laminate layup or to delete an existing laminate layup. To define a laminate, a layup
is created from previously defined plies. The layup must be balanced and symmetric. Once

complete.d, laminates can be assigned to the plate elements that make up the structural geometry.
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WhentheDefine Laminatesmenuoptionis selected,the following laminate information

dialog box appears:

Laminate Information

- ( Add

[ Modifu

[ Delete

) ;_kla_n_toghl_

_k_ n_m.

A list of previously defined laminates appears on the left side of the dialog box. The laminates are

display(M alphabetically.

• To _lect a laminate., move the cursor over the laminate's name in the alphabetical list and
(:lick the mou._: button. The laminate name darkens to indicate _lection.

• To create a new laminate, and add it to the database, click on the button labeled Add.

• To modify an existing laminate., select the laminate's name in the alphabetical list and click on

the button labeled Modify.

• 1_ delete an existing laminate from the databa._, select the laminate's name in the alphabetical
list, and click on the button labelc_t Delete.

JCreating and Modifying Laminatcs J

Selecting the add or modify options of the laminate, information dialog box described previously

results in the following display:

baiu|o: I

Lnminotes ore compoeed ors
stack of pltN. TM Itot being

s_ tM STACKING SEQUENCE
for thi= Itmln4te.

STACKING SEQUENCE

j Tk|ckll_: jo.ooooooooo J
Point end cltck to selact n plg
from the 11st being, then copV

the PIg Into the STACKING

SEQUENCE_th the copu button.

POSSIBLE PLIES

J'ly 1 ___

[-'O'o_et-e--] Delete the selacted PIg Onlq pltos that have been
previotml U deft nedore =hcvn,

(Cheage Slgn)chengesign or the selected pig's angle.

n
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The laminate's name and total thickness are listed at the upper left and right corners of the display.
The display also lists previously defined plies on the right under the heading "Possible Plies." The

current layup for the laminate is displayed on the left in the list labeled "Stacking Sequence."

Since the laminate must be symmetric, only half of the laminate is defined up to the midplane of

symmetry. The remainder of the laminate is automatically defined as a mirror image. The layup
display shows a stack of plies; the ply at the outer surface appears at the top of the stack, follo_d

by the second outermost ply, and the stack progresses inwards so that the ply at the bottom of
the stack is at the midplane of symmetry.

Laminate layup sequences are created by clicking to select plies from the list on the right and

then clicking on the copy button to add the plies to the layup. The laminate layup is rearranged
by clicking on a ply in the stacking sequence and dragging the ply to a new position; the other
plies shift to accommodate the change.

• Selecting a ply in the stacking sequence and clicking on the button labeled Change Sign

inverts the sign of the selected ply angle. Since the laminate layup must be balanced, the sum
of ply angles in the layup which are non-zero and non-ninety must be zero.

• Selecting a ply in the stacking sequence and clicking on the button labeled "delete" removes
the selected ply from the stacking sequence.

• The thickness displayed by the template, is total thickness of the laminate. Since only half the

laminate is defined, the total laminate thickness is twice the sum of the thicknesses of the plies

shown in the stacking ._wluence. Recall that laminates which physically have an odd number

of plie_ are modeled with an even number of plies by splitting the center ply at the midplane

into two plies, each with half the thickness of the original center ply.

Assign Laminates to Plates

The Assign Laminates to Plates menu option is used to associate defined laminates with

the plate elements that form the geometry. The definition of laminates is discussed in the previous

section. To associate a laminate with one or more plate elements, do the following:

1. Choose the point-hand tool or the grab-hand tool and then point and click to select a plate

element. The selected plate darkens. Multiple plates can be selected by pointing and clicking
while the shift key down on the keyboard (see the point-hand tool or grab-hand tool discussions
for details).

2. Choose the Assign Laminates to Plates menu option.
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3. The following display appears on the screen which lists previously defined laminates:

Ih, llll*,ll ,_1111(1_1 |(,'s

Select o Laminate

! i [ co,ca, ]

. Select a laminate from the list by pointing and clicking on the laminate name, and then click on

the button labcled "OK." This process associates the chosen laminate with the selected plate
elements.

Open Laminate File

The Open Laminate File menu option is I_d to open datab&_, files containing material, ply
and laminate, information. Such database, files are created with the Save Laminate File menu

option discussed in the next section of this manual. The databa._e files are used to save defined

materials, plies, and laminates for a given panel design. The database files can be shared so that
the same definitions can be u._d for other panel designs. This process avoids repeated definitions

of the same materials, plies and laminates.

When the Open Laminates File menu option is selected, the following dialog box appears:

I_ Manual J
,l|llljl,l|l' I1_'

[" [h'ipa 1

l" Open 1

[ cencal ]

This dialog box is the standard Apple file dialog box which prompts for the name of the file to be

opened. The use of the file dialog box is discu_ed in detail in the File Dialog Boxes section of

the File Menu chapter of this manual.

Existing laminate files and folders from the current folder are displayed. The name of the

current folder is displayed above the list. Once in the correct folder, point and click to select the

desired file name in the list, then click on the "Open" button. Alternatively, double-clicking on

the file name aim opens the selected file.

When a laminate databa._c file is opened, the materials, plies, and laminates in the file are

added to any materials, plies, and laminates that are defined in the current panel model.
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Warning Messages [

When opening a database file, if the database, file contains a material with the same name u

an existing material, the following dialog box appears. An analogous warning appears when two
ply namm or two laminate names conflict.

A Materiel I is already defined. Do
UOUwish to replace It?

• Click on the button labeled "OK" to replace, the existing material with the new material from
the database, file.

• Click on the button labeled _:_an_l" to retain the existing material without making a
replacement.

Save Laminate File

The Save Laminate File menu option is used to save the materials, plies and laminates in

an independent database file. This process is used to share the same definitions for other panel
designs and avoid repeated definitions of the same materials, plies and laminates.

When the Save Laminate File menu option is selected, the following dialog box appears:

i ii i

Manuoil
[__Bound Condilion$ (,,, _ c::_SCSI80

Boufldal'y C(lfl(lJiJol'l$ m[_ f'lleMenu [ [jel:l ]

L'_l (;Io1,sai_J [ Bl'ipa )
[_ (;l'nwLllai'nin 9

,_ ke_ItPOl'd,l,

Save this document as: [ Save ]

i [ Cancel]iLaminate File

This dialog box is the standard Apple file dialog box which prompts for the name of the file to be

saved. The files and Gdders in the current folder are displayed, and the name of the current folder

is displayed above the list. The names of files are dimmed. The use. of the save file dialog box is
di._ms._:d in detail in the File Dialog Boxes section of the File Menu chapter of this manual.

Once. in the correct folder, type the de_ired name for the new laminates file in the space provided
and click on the "Save" button. The file is saved on the disk.

7'he laminate Menu 40



The 0 timization Menu

The Optimization Menu options enable stnlctural optimization to be performed and are used

to construct linking equations often required during optimization. The optimizer must satisfy

these equations when choosing design variable values. Design variables are not specified with the

Optimization Menu options, but are specified as part of the information associated with a plate

element or ply.

Sizing Cycles

The Sizing Cycles menu option is used to specify the number of sizing cycles during

optimization which is the PASCO input, NAXJJJ. When this menu option is selected, the following

dialog box appears:

Number of I" '

Sizing Cycles" tu J

[ OK | ( Cancel

II[_l_llll, ,111111!

]

• Type the number of sizing cycles desired and click the button labeled "OK" to change the

number of sizing cycles.

• When the number of sizing cycles is zero, the MacPASCO generated input instructs PASCO to

perform no optimizations and simply analyze the initial panel design. This instruction is the

default setting.

Linking Equations

The Linking Equations menu option is used to create design-variable-linking equations.

Design-variable-linking equations must contain two types of variables: dependent and independent

variables. The values of the dependent variables are determined by solving the linking equations

using the values of the independent variables. In general, several of the linking equation

independent variabl_ are also optimization design variables. Design-variable-linking equations
restrict po_ible values for design variables because during the optimization process, design variable

values are limited to thosc values which satisfy these equations.
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When the linking equations menu option is selected, the MacPASCO linking equation editor

is displayed on the screen. The editor is used to create new linking equations and to modify existing
equations. The linking equation editor is shown below:

Soleclod Plies for IJ_nY/z

pluto e _ LlmIflng
[qN|iOI_

r_lalefloia: I ! Next

[ Add PleteWIdth Ic_emclelt _ I-I i, _ v_b

[,boo,,,[,..,,...)

The u_ of the linking equation editor is d_cribed in detail in subsequent sections of the manual,
but an overview is given below:

1. The equation being edited is displayed in the lower scrollable view: it is blank for new equations.

2. A plate is selected by pointing to the cross section displayed in the drawing window, using
either the point-hand tool or the grab-hand tool. The selected plate element's width can be

made a linking equation variable. The "Selected Plate #" field displays the number associated
with the selected plate element.

3. The scroilable view labeled "Plies for Linking Fxluations" shows a list of defined plies. Plies

from this list are selected by pointing and clicking. The selected ply's angle or thickness can
then be included in a linking equation.

4. Linking equations are numbered, and the number of the equation currently being edited is
displayed to the right of the word "Equation:".

5. The box labeled "Add Plate Width" is a pop-up menu which is used to add variables to an
equation.

6. The box labeled "Next" is a pop-up menu which is used to select an existing equation to edit
or to create a new equation.

7. The box labeled "C,oeflici(,nt" displays the coefficients of linking equation variables.

8. The check-box label(_ "Is Dependent Variable" is used to designate variables as dependent
variables. Dependent variablc_ are, di_u,_i in a subsequent section of this manual.

The Imtton labeh,d "Show All Equations" displays a list of all defined linking equations and

allows the equations to be printed. The printed list of the equations can be a useful summary
and an aid when cre_ting many linking equations.

.
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Adding Variables to Linking Equations[

A variable is added to a linking equation in two steps:

1. Select the variable.

• Plate elements are selected in the drawing window by pointing and clicking using the point-

hand tool or grab-hand tool.

• Plies are selected from the ply list on the upper right-hand-side of the linking equation

editor display. Move the cursor over the desired ply name and press the mouse button.

. Add the variable to the equation using the pop-up menu to the left and immediately above the

display of the current linking equation. When the mouse button is pressed with the cursor over
the variables pop-up menu, the following options are displayed:

,_Add Plate Wldth T

Rdl| Plq "[hickne,s

Add Plq Anqle

Add Right Hend Side

Oelete lJarial)le

Menu options are dimmed when they cannot be selected. For example, a ply thickness cannot

be added if no ply is _h:cted.

Add Plate Width

Choose. the Add Plato Width option to add the selected plate element's width to the linking

equation, _ shown below:

' l+,_. ii., I l. Jt:111_ +

IHmol model
Nile llfgnllUlll:

: 9_0000000

h411_411 : O,ooo000OO0
i
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The two upper windows show the

drawing window (upper left) and the

linking equation editor window (up-

per right). The editor window shows

the "add plate width" option being se-

lected, before the moo.se button is re-

leased. The lower right window shows
the editor window when the mouse.

button is relea.sed and the selected

plate+ element width is added to the

linking equation.
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Add Plete Width _.oeel_tei_ 1 O k _ v_

i
i

Ill:, ,t, 11
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Add Ply Thickness

Choose the Add Ply Thickness option to add the selected ply's thickness to the linking

equation. The ply is selected from the list of ply names in the linking equation editor display by

pointing and clicking.

For example, the window below shows the linking equation editor window after adding a ply
thickness:

• The ply named Ply 1 was selected from the ply list and added to the linking equation with
the Add Ply Thickness pop-up memx option.

• The linking equation variable name LqPiy t t, which is the ply name followed by the letter

"t +' to indicate ply thickness.

Add Ply Angle

Cho(_sc the Add Ply Angle option to add the selected ply's orientation angle to the linking

equation. 'lq_e ply is selected from the list of ply names in the linking equation editor display by

pointing and clicking.

For example, the window below shows the linking equation editor window after adding a ply

angle:

• The ply named Ply 2 was selected from the ply list and added to the linking equation with

the Add Ply Angle pop-up menu option.

• The linking equation variable name is Ply 2 >, which is the ply name followed by the character

">" to indicate ply angle.
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Add Right Hand Side

Chemise the Add Right Hand Side option to add a right hand side (i.e., the right hand side

of the equality) to the linking equation. The right hand side's initial value comes from the entry

labeled "Coemcicnt." _r e_xample, the window below shows the linking equation editor window

when the Add Right Hand Side option is selected:

When the mou_ hut_)n is released, a right-hand-side value of 0 is added to the equation, as shown
below:

PIIm let ptl, I
Seta"t_l _ LIIttlq i

Pllle • -- [_l_leu /

(Start.: I I N,xL I_

IMmlo 21 + -2"lploto olin

_ Slmow all [qwotiolle J

i Modifying Variable Coefficients or the Right Hand Side I

Coeilicicnt vah]e_ are specified in the entry labeled "Coefficient" in the linking equation editor.

To change a variahh: (_)cfl3cicnt do the following:

1. Select the varia|>le by pointing to the variable in the linking equation and clicking the mouse

button. The variable darkens in the equation when it is selected as shown below:

Iqloo for ply I

-- 1[4a_l*m /

I_,t, Zl • _- e C)
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2. Type the desired value for the coefficient using the keyboard. The entry labeled "Coefficient"
displays the value typed. In addition, the linking equttion display is automatically updated

with the new coefficient as it is typed. For example in the equation below, a coefficient of -2
has been entered.

[qw_mm: I

INmI. 21*_ = |

The value on the right of the equal symbol (=) in a linking equation is modified in the same
way that variable coefficients are modified:

1. Sclect the current right-hand-side value by pointing and clicking as shown below:

Pllim lelr p_v s

|
[allWt_N: I

Add Plate Wl_h J mw=,t I Q i._ vvuli.

Ill_lo 21 ° -_plmte I i_ ]_

U

2. Type the desired vahm using the keyboard. The display updates automatically during typing.

Dependent and Independent Variables[

As stated previously, linking equations must contain two types of variables: dependent and

independent variables. The values of the dependent variables are determined by solving the linking

equations. The values of the independent variables are considered as constants when determining

dependent variable values. It is often the case. that some of the linking equation independent

variables are also optimization design variables. During optimization, the optimization algorithm

supplies new values for the design variables, in turn, these new design variable values are used in
the linking equations to determine new values for the dependent variables.

I,'or example, the figure below shows a hat stiffener with the plate elements numbered:

4

1 -- 2 3 :3
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Thegoal is to force the widths of plates 4 and 6 to be the same and thus keep the widths of the
sides of the hat stiffener equal during optimization. This goal can be accomplished by creating the

equation:

ug_dth plate 6 = width plate

In MacPASCO, the equivalent equation,

u_dth plate 6 - u_idth plate 4 = 0

is created.

In this example, the width of plate 4 is chosen as a dependent variable, and the width of plate
6 is chosen as an independent variable and as a design variable. Hence, as the optimizer varies the

width of plate 6, the linking equation insures an equal width for plate 4.

Designating Dependent Variables

1"o make a variable a dependent variable, do the following:

1. Select the variable by pointing to the variable in the displayed equation and clicking the mouse
button.

2. Click on the check box labeled "Is Dependent Variable." Ifa cross, X, appears in the check box,

the variable is a dependent variable, otherwise it is considered to be an independent variable.

I Deicting Variables from a Linking Equation]

Variables are deleted from a linking equation with the same pop-up menu used to add variables.

To delete a variable or right hand side from a linking equation do the following:

1. Select the variable to be deleted by pointing and clicking.

2. Point to the pop-up menu in the upper left of the equation display, then press and hold the

mou_ button. The following menu options appear:

l_lJi! l>li_t_: LLlj(lJh
lh],! Plq "l'l)|i:k rle,,s

l;llJlJ I>11.1Ih'lt,|ll,?

fl(l(l Fli,(Jhl Flilrl(l $izt?
Delete Variable

I

Unavailable menu options are dimmed.

3. Select Delete Variable from the listed menu options and the variable is deleted from the

linking equation.
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Ci'umging Linking Equations ]

MacPASCO maintains a list of the defined linking equations. Initially the linking equation

editor displays the first linking equation in the list. The pop-up menu under the words "Plies for
Linking Equations" is treed to traverse the linking equation list as follows:

• Select Next to display the next linking equation. Each linking equation is numbered, and the

number appears after the label "Equation:" in the display.

• Select Previous to display the previous linking equation.

• Selecting Next when the last linking equation is displayed creates a new linking equation.

[ Show All Equations J

The Show All Equations button in the linking equation editor opens the equation summary,

a text window which lists all defined linking equations. The summary is used as an aid when many
linking equations are created. The equation summary is not editable, but can be printed for

documentation or further reference. An example equation summary window is shown below:

Linking Equations for ponelmodal

|plale 2] + -2"[plate I] = O

Ilplete 11+ -l*iplete 3] = 0 '"

The summary window contains a scrollable view which lists the linking equations.

• Sele_'t the Print button to print the list of linking equations.

• Select the OK bul, ton to close, the equation summary window and return to the linking equation
editor.
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Exam le 1: Laminated Unstiffened Plate

The first example of modeling with MacPASCO is a laminated, unstiffened plate loaded in

longitudinal compression as shown below. This example is the same as Example 1 in reference 1.

J¢/¢/¢/¢/
SS

/-/-/-/-/-
Nx = 1000 ......./11 I I I I I I III'/................................. .02"02 90°0o

.02 -45 o

.02 +45 °

The plate is 8 inches wide and 30 inches long and is subjected to a 1000 ib/inch compressive

load. All four plate edges are simply supported. The plate is a balanced, symmetric laminate as

shown above. Ply thicknesses, T, and orientations, 0, are given in the columns to the right of the

laminate sketch. The dotted line represents the midplane of symmetry.
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Panel Geometry Modeling

The typical MacPASCO user begins by modeling the panel g_metry. The initial MaePASCO
screen display is shown below:

-- _ Ontltled-I_.__

r i• Vtdtk : 0.'._"_,,_: : : : : : : _ .": _.
lletatll : CD.'_'.,):,_):,),:_.,._:_.,:=:,:,:,

I

m

The initial MacPASCO panel is a single plate, so only the plate dimensions need to be adjusted

to model the panel geometry for this example. There are two ways to adjust the plate's width: use

the plate information display or u_ the grab-hand tool to adjust the plate to the correct width•
Both methods are dvscribed.

Use of the Plate Information Display I

The, point-hand tool is selected by clicking on the point-hand icon in the tool palette window.

The tool palette icon darkens to indicate selection, and the cursor's shape changes to a point-hand

icon. The cursor is then moved over the plato in the drawing window as shown below:

s Untitied-I _m_l

Ploto Information:
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l)oubh,-clicking the rnou_ when the cursor is over the plate displays the plate information box
shown below:

Plate information:

:Vldth : 20.0_00_00000000

Itetathm : O.- ................

Jlate Information []Lock PlateGeometrv

Width: 2O. - ......... I"1_,s_ Va-_,

t.ovar BoNnd Upper Bound

{).,:,;,:,:,:,),:,:, o(}O{X)_'JJC_.':':':":":':':':'

b|allol: 0._

Leminele: Undeflcud

, OK i ( CoIIcoI 1

The plate information display shows the plate's width and rotation. The number 8 is entered

from the keyboard as the new plate width, which results in the display below:

_'I,)T*' I1_ tllllld'_l,)!)

Plata Information IR]LockFlateGeometru

I _qdtb: e r_ v_
l,uvBr Bollnd IJppvr llaund

O ".'-'-'.'.,',,'.:, t£)().rX_!._Y.)[}.,:.:,,:,,:.:.:,,:,.:,

Itetat|el: O_G_CCOOCCCGO_GO

Lain/ride: Undef4hed

, Ol( , ( Ca.cOI 1

After clicking on the button labeled "OK," the plate width changes to its new width, as shown

below. The plate is darkened because it is selected, and the m_sage box shows the selected plate's
width and rotation.

ND_ Unfitted-! l_l

Plata information:

V11dt_ : 0.000_000000000000

lottatlJee : OJnG_CQOCGGCGGOOO00
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[ Use of the Grab-hand Tool ]

The grab-hand tool is _lected by clicking on the grab-hand icon in the tool palette window.
The tool palette icon darkens to indicate, selection, and the c_lrsor's shape changes to a grab-hand

icon. The cursor is then moved over one of the end nodes of the plate in the drawing window as
shown below:

Untitlad-I

The grab-hand curer is positioned so that the cross-hairs are over the plate node. Move the node

and the plate changes dimensions to follow the movement of the mouse as shown below:

M : 16JItrNsIll _ _ #i_rlI

: IB_TIILIII4tlTJ_ IIMMIm : I.ll

J

u i i= i

The message box displays the width and rotation of the plate as it changes dimensions so the plate

can be made the correct width. Once the plate has the correct width and rotation, the mouse

button can be released. Sometimes, it is not possible to azijust the plate to the correct width with

the grab-hand tool, in which case the plate information display must be used.

Panel Length and Loads

The panel length is defined using the Apply Panel Loads option of the Panel menu. Moving the

cur_)r over the Panel menu at the top of the screen and then pressing the mouse button displays
the Panel menu options, shown below:

Number of Repeating Elements
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The Apply Panel Loads option is selected by dragging the cursor until the option darkens and then
by releasing the mouse button. This action displays the current panel length and load conditions.

The number 30 is entered as the panel length and I000 is also entered as the N= load, as shown
below:

1',IIl4'I thll[%

0o

  oooo..oo.,
P°°° I

! o_ ! [ cs.., ]

Boundary Conditions

Only boundary conditions along the lateral edges of the panel can be specified. PASCO assumes

sinu_idal behavior in the longitudinal direction which results in simply supported end conditions

for thc longitudinal edge_.

The boundary conditions on the lateral edges of the panel are initially free in MacPASCO, as

indicated by the notation f! at the start and final nodes. The start and final nodes represent

the left and right edges of the panel respectively. Boundary conditions are defined using the node

information display. The point-hand tool is selected and the cursor is positioned over the start or

final node, as shown bclow:

I$ ID_ Untltled-I /111_1

Plate Informallon:

Vkltk : 8.OOCO00000C_C_

• etatkm : 0.00000000000000_

1

_! uII_[l$iU$il?$".,lii!_,_liU$i11P,!IHIllii$[|l!$_$t$_,_i$$|_]
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Clicking the mouse button displays the node information on the screen as shown below:

Plato Information:

VMtk : 8,00000C_00_000(_

Oetatlel : O.OO_O0_O000_O0

[Cancel]

Positioning the cursor over the current boundary condition and p_ing the mouse button displays
a choice of boundary conditions. The choice, of boundary conditions remains displayed until the

mouse, button is relea:_A_l, l_r this example, a simple support boundary condition is required which

correspon&q to MacPASCO's S52 boundary condition. A table in the boundary condition section

of this manual describ_ the notation for each boundary condition in detail. The S$2 boundary

condition is selected from the choice, of boundary conditions by moving the cursor until the desired

boundary condition darkens, as shown below, and then releasing the mou_ button:

Plate Information:

Vidl_ : II.OO_OG_GCOOGG_QO
Retatll : O.OO_O0_O0000_O_

Nede Imrnatke

z[__

,_ Free (F I )
F2

F5
F4

Simple Support (SSl)

SS$

SS4

Symmetry (Sl)
S2
S$
S4

Clamped (C I )
C2

C5
c4
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The figure below shows the screen display after both boundary conditions have been defined as a

simple support (SS2):

is ili[_ Untltled-I

I Plale Information:

Iiv_th : e.oo¢ooo¢0o¢¢¢ooo0

JRetatkNt : 0._

I

i
I

ss2 s$2

Laminates
I

The panel geometry, loading cxmditions, and edge conditions have been described, but the laminates

used in the panel have not been modeled and associated with the geometry. A laminate consists of

layered plies of material, where each ply is of a specified material, thickness and orientation. There

are three steps to modeling a laminate, in MacPASCO. First, the properties for the ply material
are. defined. Next, the material, thickness, and orientation for individual pli_; are defined. Last,

a stacking sequence is defined for each laminate. The stacking sequence defines how the plies are

layered to form a laminate. Once a laminate is modeled, it is a-q_ociated with the appropriate parts

of the panel geometry.

[ Material Definition I

In this example, all plies are of the same material. This material is defined using the Define

Ply Materials option of the Laminates menu. When the Define Ply Haterials option is

selected, the defined materials list appears as shown below:

mluadmm

Material Information

AddI ] Adcl &MW RM_tothe ist

( Modify }wy_.

[ 0e,ate]

[ ooN l
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Material properti_ for aluminum are included by default. Clicking on the button labeled "Add"

displays an input template for material properties so a new material can be defined. The figure
below shows the material property template after the appropriate property information was entered
for this example.

Meberiml IWIll _mlwJit, i

t, i,_6 i *Mu' I°'3' I
[z Is.eg,6 I *Lr*e [-O.S.-e [

[12 p.3.s 1'It'212''b's 1
J.o lO.OS_l I

Material Failure Criterion and Allowables

Criterion:[ Strain J

(¢1 -_IAT) cempres_ion [0.004 J

(cl - o_tA"O tension i-o.0o4 I

(cz - _T) compr,.lo, [0.004 I
(,=- o_AT),..i0. I-°-°°4 I

_,z._.r I0.01 I
_',:: .,h.,.,, i0:,.,:,.,:0,:_,_,0.i[ DONe]

For this example, a strain failure criterion is selected. A click on the button labeled "Done"

dismi_ the template and displays the defined material list, as shown below:

Material Information

0___{ Add } _klt,4.1mn,o
th* lit

{ Modify 1 wv,_,
sdi_ld Item,

( Delete } c_sel_ecl ilem.

[ DoN[!

The newly defined material appears in the list.

A click on the button labeled "Done" dismisses the materials list display.
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Ply Definition ]

The laminate used for this example is repeated below:

T 0

._.__ "02 _5 °

.02 -45 o

.02 _ •

• _-..._ 0 °.02 -45 o
.02 +45°

This laminate can be constructed by defining three kinds of plies: a 0.02-inch-thick 45 ° ply, a

0.02-inch-thick 90 ° ply, and a 0.01-inch-thick 0° ply. The 0° ply is only 0.01 inches thick because

laminates are only defined to the midplane of symmetry. The -45 ° ply is cre_ted from a +45 ° ply

when the plie_ are layered to form the complete laminate.

l'_m:hply isdefinedusingtheDef Ine Plies optionofthe Laminates menu. When the Define

Plieo option issclec.ted,the definedply listappears asshown below:

Pig Information

o [ ndd ]u.--_,.

[Mo ., ]_amm.

Initially, the list is empty.

Clicking on the button labeled "Add" displays an input template for ply information so ancw

ply can be defined. The figure below shows the template after appropriate property information

was entered for the 45 ° ply.

m h.: IP_ I

!**ek: ps.o I [] D,.l_av,t,v,
Lever Ilelmd Upper bnd

_.ooooooooo I 136o.oooooooo I

Tldckmu|: _O.b20OO000 I [] I_lqln v,rlal:ie ]

Lever 90104 Upper Ileum

oooooo,oo I /i"oooooooo I

Ivlaterle! Temperature

1,
The ply thickne_ and angle have been selected as design variables for optimization as indicated

by the cross (X) in the design variable check box in the display. A click on the button labeled

"Done" returns to the defined plie_ list, and the new ply name appears in the ply list.

Example I: [_zminated Unstiffened Plate 57



The information for the remaining plies is input the same way: clicking on the "Add" button to

display the ply information template, entering the information, and then clicking on the template's
"Done" button. The figures below show the input templates with property information for the 90 °
and 0 ° plies.

Mg -----: p,u j

Lever bead Ilp_¢ Sued

mm'mr-----] p+o.oooooooo I

_NI Iteelle Vorlokle

I.m_r lend Ilple¢ Ioood

1I'°°°°m°° I

Lever he 'd Upper bud

rover lioeed mlq_r bud [

I J
lkJeto01el Temloretu5

For this example the ply thicknesses have been chosen as design variables. Also, the ply angle is
a design variable for the 90 ° ply, but not for the 0° ply. The defined ply list after all three plies
have. been created is shown below:

Ilare

PI U InfotmeUon

<>1 Md 1+"'""".,.,.,

[ "+o,mv] ,,,.,_,,,.lJ_ lllm,

[ o,let, ),._.ksdeetedi_m,

I Laminate Definition I

The panel in this example only requires a single laminate, which is defined using the Define

Laminates option of the Laminatoi menu. When the Define Lwninates option is selected, the
defined laminate list appears, as shown below:

Laminate Informellon

>[ ndJ 1'+"'.-+'.-'.- Ihel_
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Initially the list is empty; clicking on the button labeled "Add" displays an input template used
to defne a new laminate. The figure, below shows the initial input template.

LIIIII| ill|l: [

Lemllwtee tee compoud ofe

dek of p|loL The |let belev
eMvo the STACKING S(QU[NC[

fir thlo limit.

STACKI IIG SEQUENCE

TkIetNU: [O.OOOO00000 J

Point end el(ok to NINe O pIAI

from tM list icier, Ihen cepq
the ply tMe the STACKING

51[QU(NCI[ vtth Ihe copq butAon.

PINI$111LE PLIES

_ Delsie the xlo©ted piq On| U plleo Ihet _ been
prwto_l v defl_ ere shevn.

CChangeSign_che_etgnot'*_seToctodplv'oo_ll*.

The list of defined pli(,_s appears on the right. The sequence of figures that follow show the creation

of the laminate by ,_.'h.,cting defined plie_ and adding them to the stacking sequence.

for lhle Iomlneto.

STACKING SEQUENCE

L,=,.,o: I_''t° , I m.,,..: Io.oggo.ogg ]
Lomtnetoe ore composed of e Point end cltck to mloct e ply

stOCk of plies. The list haler from the 1let belay, Iheen ¢epq

shevs tM STACKING S[QU(NC( Ihoe plq into the STACKING
S(QU(NIC( '*dth the ¢opq b_a.

POSSIBLE PLi(S

qm
__lo_ the nlectd PlAI Only plloe thet hove boon

prevto_l Vdefined ore shorn.

(Change Signlcheneesignofth*Nl_'t_l pIV'sen¢lo.

The 45°ply is selected from the ply

list and copied into the laminate layup

using the copy button.

LeIIM_IO: IIjmdno, to I TMek_ee: Jo, 04000000 J

Leml _etee ore oemp4ml el' o Psi nt end ¢110k to OCloct o ply

stick of plies, The list haler from the )I;t helw, then mpv

eh_e Ihe STACKING $1_U(NC[ the IdV 1hie the STACKING

for thie IomtMhb. SEQUENC( with the copy buttes.

STACKING SEQUENCE POSSIBLE PLIF.S

f-'O0-1"0"I"I'7 hlsto the s, loctod ply Onl' v plla thet hove been
Frwfeue) v defined ore shews.

(ChangeSign')che_oetchofthe_1_1 I_V'owqlo,

T 0

__ *4so*4S e

After copying, the 45°ply appears in

the laminate layup. At this point,
the laminate, consists of two 45°plies

(recall that the stacking sequence only

shows the layup to the midplane of

symmetry).
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A second 45°ply, a 90°ply, and a 0°ply are added to the stacking sequence resulting in the display
shown below.

u"'_: ILww' l .,,k,m: I0.I-oo_ I
LamlMtse ira Wml_ e( ¢ Pe10d ill ollck to select t ply
stuck of pl(se. The llld helev firm the IIM belev, then WAy

chevs the STACKING SEQU(NC| tke ply Into the STACKING

for Ibis IomiMde. SEQUENCE vlth tits Wily buttol_.

STACEING SmU[NC[ PIIGSlllL[ PLIES

4.,oN, _ I)4

se.m

)4

fG

Mle

knr¢ O .seOO&

_ Dolidio the selected Only pllse tlu_ have beenply
prwgomlv deft ned ere olw, on.

Cchenge Slgnlcheno, _ of the selectod ply's nolo.

T 0
.02 448 °

.02 ",45 °•02 gO o
-" ' .0_ 0 °

The laminate is almost complete; all

that remains to be done is changing

the second 45°ply into a -45°ply.

LUMNI.: ILendmto i TkOckNm: I 0. I,IO000OO ]

Leo4 poise ore compseed of o PelM led click to selecto plp

sleek of pllN. The IIM IMlev from flus ltM kelev, then sepv

14mve the STACKIPIG $EQU(NCr the ply tMo tim STACKING

/or tide lend sets. S[QU[NC( vttk the copy button.

STACKING SEQU[IIC[ PO_IIL[ PLIES

N, 4,.m, t _.. 0

_ Deists tho selected Only pllco that hove boonply
prev_owly defined ors shorn.

_LimcheN* _ of lhe selected ply'c ,nolo.

The display for the completed laminate is shown below:

II L.=t.t,- IL.._.t. I Tklekuloa,,o: I,..-oooo I

LondnMse ore comilseiM oft PoIM tim click to mlxt o ply

stalck of pllse. The list helev from the list helev, then copy

oheq_; the STACKING SEQUENCE the ply IMo the STACKING

for tide lomlMto. SEQUENCE vltk the copy button.

STACKING SEQUENCE PO_SlIDL[ PLIES

N.SeO0

IkNr. O,eseco

_ Dele4e Only pltco thM he4 b,ontho _octed PlY
prwtowly doflsed _o ehev,.

Ichengo slgn}¢he_ _nynofthesel_.t_ plv'c*nolo.

The second 45°ply is selected by click-

ing on it. The ply angle is changed to

a -45°ply by clicking on the Change
Sign button.

T O
4_tS o

,O2 -_k_ °
,0_ 5;0 °

._ -4_ °
,_ _1_ °
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Once a laminate has been defined, click on the "DONE"_ button to dismi_ the input template and

return to the defined laminate list, shown below:

l[Ami_Q_

Lamlnote Information

_0 ( Add I d_k*d*n"k''°l_

( Modify .1 I_m,/_h.s,l_ted i,m.

se_*d item.

[ ooNt]

The newly defined laminate's name now appears in the list. The laminate list display is dismissed

by clicking on the "Done" button.

On(m the laminate is defined, the laminate mlmt be associated with the panel geometry. In this

example, the geometry is a single fiat plate. The plate is selected using the point-hand tool, and

then the Amsign Luinates to Plates option of the Laminates menu is selected. The resulting

display is shown below:

Plata Information:

Vtdtlb : 80_GOOGO00000_]

ss2 _2

Select • Laminate

( Cancel ]

The drawing window appears in the background, and a smallcr window appears listing the defined
laminates appears in the foreground. In this example, the list contains only one laminate defined

previously. The laminate is _lected by clicking on the laminate name. Clicking on the "OK"
button a._ociates the _lected laminate with the selected plate(s) and dismisses the laminate list

window.

Buckling Mode Wavelength

PASCO examines a serie_ of buckling modes. The modes considered is determined by A, the length

of the minimum buckling mode half-wavelength. For example, A = (panel length) means a buckling

mode with a half-waw:length equal to the panel length is examined. When A = (panel length)2

both the panel buckling mode with a half-wavelength of half the panel length and the buckling
mode with a half-waveh:ngth equal to the panel length are examined. Of all the buckling modes

examined, PASCO outputs the critical buckling mode (the mode with the Iow_t buckling load).

The u_r controls which buckling modes are to be examined by specifying the smallest buckling

mode half-waveh:ngth A to be examined.
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The value for A is specified p.sing the Eigenvaluee option of the Panel menu. When the

Eigenvalues menu option is _lected, the following display appears:

II|l'tlll,ltlJ,'_

Sm411est I_lf-vave_ngth

f., ,,h_ b_kl_ I.,_ X. II. oooooooo I
are ex,lmk_

I am I ( to.+.' ]

For this (:xamI)le, the panel length is 30 inches. A vahm of A = 1 is specified, which instructs

PASCO to examine the buckling mod(m with the G)llowing half-wavelengths:

3O ,'K) 30

30' 29' 28'
.. and --30 (the panel length)

"_ 1

Of all them buckling mod(_, PASCO only outputs the critical modes with the low_t buckling load.

Sizing Cycles

The Sizing Cycles option of the Optimization menu is used to indicated the number of sizing

cycles during optimization. When the Sizing Cycles option is selected, the following dialog box
prompts for the number of sizing cycles:

+![_!IflllZOtl+++ _.

Number of

Sizing Cycles Io I

Cancel 1

Initially, zero sizing cycles are specified, which r(mults in analysis only without optimization. For

this example, a single sizing cycle is specified by typing a one in the dialog box, as shown below:

!|_IIII;IZ,J_'

,.m. o, -I, I$1zln9 Cycles

( Cancel 1

On<._. the number of sizing cy(:h._ is entered,
button labeled, "OK."

the dialog box is dismi,_ed by clicking on the
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Generatethe PASCO Input

At this point, the panel itself is modeled, and the analysis and optimization conditions are specified.
All that remains to be done is to generate a text file containing the appropriate PASCO input by

selecting the Hake PASCO Code option of the File menu as shown below:

New NN

Open...

,s _ ;_ _.]a Ikl|Ll,[ll 111 [lII |-

Close

Save As...

Save a Copy In...

Page Setup...
Print One

Print ...

Quit NQ

When the Hake PASCO Code option is selected, a file dialog box appears to prompt for the name

of the file to be generated.

The PASCO input fih: generated by MacPASCO is shown on the following page. This text file

is input to PASCO to analyT_ and optimize the example panel.
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MacPASCO output for Example 1

F.,xample_ 1. INPtrr
$CONDAT

$
SPkNEL

B(1) = 8.0,

IWALL(1) = 1,

ICARD(1) - 5, 1, 2, 1, -909, 0900,

3, 2, -909, 0900,

EL = 30.0,

NX = 1000.0,

NY = 0.,

NXY =0.,

MX = 0.,

PRESS = O.,

T(I)=-O. 02,

TL(i)=0.000001,

ra(x)=1.o,

znm'(x)=-4s,o,

THETL(1) =0.,

THETU (1) =360. O,

HAT(I,1)= 1,

TF_(i,t)= o.,
T(2)=-0.02,

TL(2)=O. 000001,
TU(2)=t.O,
THET(2) =-90. O,

TIJETL (2) =0.,

THETU(2)=360. O,

t,UtT(2,1)= 1,

"I_(2,1)= o.,

T(3)=-0.01,

TL(3) =o. ooooot,
TU(3)=1.0,

THET(3) =0.,

MAT(3,1)= t,

TEN(3,1) = 0.,

KNALL(1, 1) = 1, -1, 2, 3,

AIIU(1) = 1. OE30,

A33U(1) = 1.0E30,

DIIU(t) = t.OE30,

IP - 2,
LINK " O,

MINI.AM = 30,

MAXJJJ = 1,

$

$MATER

E1(1)= 1.90000e+7, E2(1)= 1.89000e+6,

R/'IO(1),,' 5.71000e-2, AND1(1)= 3.10000e-1,

ALFA2(1)= 2. 18000e-5,

ALLOW(I,1) = 2.0, 4.00000e-3, -4.00000e-3,
-4. O0000e-3, 1. O0000e- 2,

E,zamp/e !: Laminated llnsti_cnedPlate6_

E12(1)= 9 .30000e+5,

ALFM (1)=-5. O0000e-9 ,

4. O0000e-3,



Exam le 2: Blade-Stiffened Panel

Tim second example of modeling with Macl)ASCO is a laminated, blade-stiffened panel loaded

in longitudinal compression as shown below (not to .scale). This example is similar to Example 2

in reference. I.

f 52

¢/¢/././¢/¢/./,/,/¢/¢/,/

/,/-/,/-j././,/,/,/,/./"
Nx = 3000

S_ln

Blade Stitfenor

E

f

Blade

J

--1 I
\
Attachlent

flange

ss

laminate t

0. 004 46 °0 004 -45 °
%\\\\%\\'_, 0. 004 -45 °

0. 004 45 °

O+01 0 °

O. 01 0 °

O. 004 46 °o oo4 -4s?
_\\"_\%%\", O. 004 -46 °

0. 004 4 I_e

[Mllnato 2

A\\\\\\\_

I,///////L
A\\\\\\\_

0.004 4S:
0.004 -46
0.004 -46_
0.004 45 °

0.04 0 °

0.04 0 °

0.004 4_
0.004 -4_
0.004 -46
0.004 45 °

;_uL1Jmte 3

0.004 45 °0.004 -4s_

0.004 -45"

0.004 45:
0.003 0 o
0.003 0 o
0.004 4S
0.004 -4s?

/K.\_\\\\NI 0.004 -45 °
_'///////J 0,004 45 °
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The panel is30 inches long, has sixteen blade stiffeners,and is subjected to a 3000 Ib/inch

compre_ssiveload with symmetry boundary conditionson the lateraledges ofthe panel.All sixteen

stiffenersare identical.Three distinctlaminatesare used: a skin laminate,a blade laminate,and

an attachment flangelaminate. Ply thicknessesand orientationsforeach laminate aregiven inthe

columns tothe rightofthe sketchesabove. The midplane ofsymmetry foreach laminate isdenoted

with a dotted line.All pliesare made of the same material.Design variablesforoptimizationare
stiffenerspacing and ply thicknesses.

Modeling this blade stiffened panel illustrates several MacPASCO features that were not shown

previously while modeling an unstiffened plate (example 1). MacPASCO modeling tools are

required to model the blade stiffeners. [n addition, stiffener spacing and ply thicknesses are design
variables during panel optimization, and linking equations are used to insure uniform stiffener

sizing. The discussion that follows concentrates on MacPASCO features that were not discussed
in the unstiffened plate example.

Panel Geometry Modeling

The u_)r's first task when modeling a stiffened panel is to identify a substructure that can be

repeat(;,| to form the panel, in the case of the blade stiffened panel, a single blade stiffener is

chosen _m the repeating substructure which repeats sixteen times across the width of the panel. If

the blade stiffeners were more irregular, one might be required to define each stiffener individually.

The blade stiffener is modeled with plate elements, as shown below:

Blade Stiffener Plate Element Model

/ l F----1 - Lam:lnat • 1
1.6"

m" Laminate 2

- Laminate 3

r. Q

The blade stiffencr appears on the left, and a plate element model appears on the right. The blade

stiffener is modeled by five plate elements, which are numbered above. The small squares represent

the junction or attachment points (nodes) of plat(: elements. MacPASCO's modeling tools are used
to create the plate, elenmnt model in the ligure above.
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IScaling the Display I

The lirst consideration is the scale of the screen display. The scale determines how the screen

coordinates correspond to actual coordinates, just as the scale on a road map indicates how inches

on the map cx)rrcspond to miles on the actual road. The scale is chosen to make drawing and

manipulating the blade stiffener as convenient as possible. The Scale Current View option of
the View menu is used to scale the screen display. When the Scale Current View option is

selected, the following dialog box appears:

I't,nt_. Ibb_l,l,uq _,1 ,lllllq

l).lilJlllll

t_ the dlspl*u Obey# b Sc_blnUour models. The

dlsplnv eho,,,s hey the vtnuel dtnplev of a pinto
rolntu In the plnto's v4_h.

To chenOe the IHC_Io, JUet enter e nov v|dlh u e
number hetveen 0.001 end 1000.

| OK I [ Cencel J

The scale dialog box shows the scr(._m display of a plate clement under the current scale. The

blade stifl'cner is only 2 inch(m wide. Under the initial scale, the screen display of the blade would

be inconveniently small, a.s shown below:

o o ffi !0.0

The plate element of the scale dialog box I_x_ks like a reasonable display of half the blade stiffener

width, ms shown below:

o o = 1,0

fl
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l,¥om the scale dialog box, the keyboard is used to change the scale as shown below. Clicking on
the button labeled "OK" dismi._.ses the scale dialog box.

• • I |

Use the displq eleve to _d, vewr tamale. The

(_opIIV show hey _ke v_eml _eplel _ I ple_

rele_ to the Iflde'e vNth.

Te chenoe the role, Jwt enter t Mv vtdth N e

number between 0.001 end 1000.

u.

Adding Nodes J

The add-node tool is selected to add nodes to the initial screen display. Then the cursor is

moved over the plate element in the drawing window. Clicking on the plate adds a node, which

will serve as an attachment point. Dragging the cursor moves the new node as the node is added.

Ilolding the option key on the keyboard down while adding a node allows the new node to be
dragged without changing the plate rotations, as shown below:

il_NflN-I _ u'iltfal-! ii_ ' ' Iq

]'1 . I_,

The cursor becomes a plus (+) when the add-node tool is selected. Adding a node divides the

original plate element into two new plate elements. The message box shows the width and rotation
of the plate element represented by a dashed line in the screen display.

Two additional nodes are added in the same way; the result is shown below:
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Adding the Bladel

The add-pla_ tool isused to complete modeling of the blade stiffener.The add-plat_ tool is

_|ected from the toolpalette.,and the cursorismoved overthe centernode in the screendmp|ay,

as shown below:

Untltlod- I

Plelo information:
VI_ : 0.,:=:='.:=:.:._='=_.:.'=_='='=:.:.:,

Pre_ing the mou._ button ad&_ a new plate clement which is dragged into the correct position,

as shown below. The me_,sage box displays the platc width and rotation its dimensions change.

Iilltlell, I __i

_luii IiIitl.lllll; I

I ; I_IIlt

i

illUlloi-I

I P_ke Imfe_imlim_
: I AIJl141_11M)111_i

I

I

11111111141-I

1141111h_hmltle_

vwm : ! .........

i i II

In the two right-hand figurr_ above, the drawing window scrolls as the mouse is dragged downward.

In the rightmost figure above, the window has _rol|cd down _ far that the top of the stiffener is

no longer visible.

After completing the blade, the u_r adjtmtsand re_iz_es the window so that the entire stiffener

is visible, as shown below:

• Intllllld-I I

PIIIO Inforninllon:

/

This completes the b_ic geometry of the blade stiffener.
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Repeating Elements

The Number of Repeating Elements option of the Panel menu is used to specify that the

blade stiffener is repeated sixteen time_ across the width of the panel. Selecting the Number

of Repeating Elements option prompts for the number of repeating elements. The prompting
dialog box is shown below after sixteen repealing elements were specified.

Repeetthe current croos-aectton

_ ttmel te ferm the
-socflor_, The vhele

Mr41 ct_ M Men vtth the "Shev
Entire Penel" menu cemmeM,

Panel Length and Loads

The panel loads and length are specified using tile Apply Pane). Loads option of the Panel menu.

In this ea._, the panel length is specified a.s 30 inche_ and 3000 lb/ineh is also entered as the Nx
load a.s shown below:

xu

l,°.°°°°°°°°°1 "_' I°-°°°°°°°°°I
P°°° I

[ oK ! { co.c., }
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Boundary Conditions

Boundary conditions on the lateral edg_ of the panel are specified using the node information

dialog box, which is displayed by clicking on a node. The node information box displays whether

a node is the start node, representing the left (_gc of the panel, or the final node, representing the

right edge of the panel. In this case, symmetry boundary conditions are cho._n. The figure below

shows the selection of a symmetry boundary c_ndition on the final node, reprL._cnting the right
edge of the panel.

kip Illedo

Pinto Informollon:

: O.,:.(-:.¢<6:.(.X-X.X._.:,

1lllillml : O_;_:.Ze:.:_.:_:_:.X.X._, [.,I
Io_,tM.,. ®f.l_,,, 0

I:E)

H

_' Free (FI)

F2

F$
F4

Simple Support (SSI)

SS2

SS$
SS4

S2

S$

S4

£lempod (C i |
C2

C$

C4

Laminates

Recall that three distinct laminat(_ are tLs(,,d in the blade stiffener: the skin laminate, the blade

laminate, and an attachment flange laminatc. Each laminate consists of layered plies of the same
composite material, where each ply is of a speciiic_i thickness and orientation. There are three

steps t_) model laminates in Macl)ASCO. First the properties for the ply materials are defined,
next individual plies are defined, and lastly the stacking sequcnc_ for individual laminates are
defined.
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[Material Definition I

As discussed in the Material Definition section of example 1, ply materials are defined using

the Define Ply Haterlals option of the Laminates menu. The figure below shows the material
property template for the composite material:

Iletori¢l Ibm _omposlte I

[! I,.6 l,.u. Io.3_ j
[z I1.0_6 i _'LFA! I-°'_''° I

[,z I,_s I ,,FAZIz,_-s I
m IO,OSVS I

Material Failure Criterion and Allowables

crsterson:I Strain )

(¢1 -c¢IAT) c_mpra:sionIo.oo4 I
(¢1 - =1/,'I) t.ns|on I-0.004 I

(¢2 - a2AT) compre_fon 10.004 I

(tz - _T) t._1on I-o.o04 i
vlz ,h._ Io.o1 I

r. I:: ,,h,_r JOOt_,Ot'_OOO(_OOOt'_]

JPly Definition J

The laminate_ used in this example arc shown below:

Blede Stlttener

lang •

Blade "_

Skin

I////////,

LoJLtntt e 1

0.004
O, 004
0.004
O. 004

0,01

0.01

O, 004
O. 004

0. 004O. 004

4S°
-4S 0
.rE °

4S°

0°

0o

4.e,
-4§
-46 °

46 °

Lalimte 2

= .,,/J////f_

/

O. 004
O. 004
O. 004
O. OOq

0 04

4G°
.46 °
.45 °

4S°

0°

O. 04 0°

O. 004 4G°
O. 004 -46 °
O. 004 -4G °
O. 001 45 °

m =

LeJL_t e 3

,////////J O. 004 4§
/,.\\\\\\\_ o. 004 -4e
.*%%%%%%%%%10.004 -4§
l//I/////J 0,004 4!

/ l o. 003 ©
/ I • oo3 ©
"_ o, 004 4e

O. 004 -46

O. 004 -460.004 46
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These laminates can be constructed by layering four kinds of plies: a 0.004-inch-thick 45 ° ply, a
0.01-inch-thick 0° ply, a 0.004-inch-thick 0° ply, and a 0.003-inch-thick 0 ° ply.

In MaePASCO, plies are defined using the l_fine Plies option of the Laminates menu. Since

the details of ply definition were discussed previously in the Ply Definition section of example 1,
the following figures only show the ply information displays:

ml am.: i.,a._. I

Lovw Ikmml Upiwr bin I

TUd..- io.o0_ooe I
Lever held IplIT'.,. I

r.'.'.':+_ ] l,.OOOOOOOO I I

Mg IIum: p_ro ]

+uqb: lO.OOOOOOeOO 1n _ _o,01
LIn_r Ieull Uppr I-i_l I

0o_,:,0,',_ 110o+_,,',,,+_,', II

Lewr I_ml Upper I_N I

o,ooo0 IP .°°°°°°°° I I
Mlledel Tellmntero

_t ""-: p./4s l

+q,m: _ In_w vm._,o
L_sr huml UN_r bin

Pugu...: p,uv_r. I

A_: Io,ooooooooo 1CIkeap vm_Io
Liar BeuIl UpINrr l)eild

oouooo_ I I°ooo_o_o,', I

vlici_- io.o,loOOOOO I [] _mlla v,_,il,

Lever bad lipl_r lhmud

o.oomoooo I p.oooooooo I

Mmledmi Tillplrlllrg
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Theplythicknesseshave bccn selected as design variables for optimization. Since only one 45°ply

(Blade46) has bccn defined, the same ply is used in all three laminates (blade, skin and attachment
flange). It may bc that the optimal design uses a different thickness of the 45°ply in the blade
than in the skin and attachment flange. To permit this possibility, an additional 45°ply is defined

as shown below:

Lever geeml Upper hun

_,.,-_o- ] Io-o_ .............I

lldckm_: [0,00400000 J [] o._lea V.rl_Io

Lover Ik_ll Upper DHiM

p.oooooooo .J

"- 14mlorhd Tempelltore

!_1o.ooooooooo

The Blade4S ply is us_i (see the next section) in the stacking _quencc of the laminate for the

blade, and the Skin45 ply defined above is u._d (see the next section) in the stacking sequence of

the laminates for the skin and attachment flange. Thus during optimization, the thickness of the

Blade45 ply in the bhide laminate is independent of the thickness of the Skin4S ply in the skin

and attatehment flange.

ILaminates Definition ]

Since the details of larninate definition were discussed previously in example l, only the final

stacking sequences for the laminates required for the blade stiffener are shown below. The laminates

arc formed from thc plie_ defined in the previous section of this example.

nm

Lenllmle: _Sidn Lomlnot. J Tkicknele: Io..eooooo J
Lendl_te¢ ere composed of e Pol nt end click to select o ply

stack of plies. The list belov from the 1151 belov, then copu
shays the STACKING 5(QUEHC( the pIv into the STACKING

for this InmlnMe. SEQUENCE vilh the copi button.

STACKING SEQUENCE POSSIBLE PliES

--'hl'ele'_ Delete the selected pl U Onlu plies tl_i hevo hes_
previous1V deft ned ore s horn.

[Change Slgn_clvinge Idgn of the selected plq's eagle.

The skin laminate is used in the two

plates that form the skin of the blade
stiffener.
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Lonlulo:

Laminates ere cempesedof o
|tock of pltoe. Thell|t belay
Iha_,_ the STACKINGSI_UENCI[
for this |omtnito.

3T_ICI NG SEQUENCE

[P'lonceLomtmlo ] TkiekNm: I o. _Ioooo0 J

Point end ¢11ck to xlect o ply
from the loot belev, tha_ espy
tha P|U |Me the STACKING
SEQUENCIrvlth the copqJbutton.

FqOSSIBLE PLi[$

_ Dololoflu xlect_ pig Only plies that have been
pre_ewlv doffesd ore shown.

[£henge Sign_Change otgn oYtha eslected plV'neqlo.

The Flange Laminate is used in the

two plates that form the attachment

flange.

LI.IIIII,: [eledo Lomtneto ] I
Laminates ore compoecd of o
stockor plies. The list haler
shays the STACKINGS(QU[NC(
for this Iomtaeto.

STACKING SEQUENC[ POSSIBLE PLIF.S

"'" I I

b'"d,,, o.eso,______ i,ku,_.,.

'-'_ Oeloto Onlv plies that havo beenthe selectod piq
prevlouo! V deftnodIre shorn.

IChenge Slgn]chenge sign of the selected pIV'oonglo,

ThIetNSO: Lo' 04000000

point end click to eslect o Ply
from the ltot _lov, then cepv
Iha plq |m the STACKING
StrQU[NCIrqu0tthlha copqbutton,

The 131ade Laminate is used in the

plate that forms the blade of the stiff-
ener.
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Once the laminat_ are defined, eadl laminate is assoc4ated with the stiffener geometry. A

detailed discussion of this process appears in example 1. The plates which form the skin of the

blade stiffener are selected with the point-|.md tool. Next, the Assiga Laminates to Plates

option of the Lamirmtos menu is uscd and the "Skin Laminate" is selected from the laminates
window &_shown below:

MP Blade

Plate Informatlon: I

¥idth : 0.8000000000000000 I

Retatiee : O_O(XXX)00CO000000

m
w

sl
5 _i m

Select a Laminate

Cancel ]

The blade and attachment Ilangc latninal,cs arc as._ciatcd with the structural geometry in an

analogous manner. The following two [igures show the as._ciation of the "Blade Laminate" and

the "Flange Laminate" nmpectivcly:

MP Blade

Plate Information:

VMtb : 1,_000000000000000

RetatJee : 2TO.O000000000000000

Select a Laminate

{ Cancel ]
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MP Blade

Plate Information:

Vidtk : 0.2000000000000000

RetaU,u : O.OOOOO(X)OOO(X)OOO(_
i

-- , m (3
sl

Select a Lamlnate

II
I Cancel

Buckling Mode Wavelength
i I

As discussed previolLsly in example 1, the minimunt buckling load half-wavelength, _, is specified

using the Eigenvaluea menu option (ff the Panel menu. As in example 1, A = 1 is specified for
the blade stiffened pand.

Optimization of Stiffener Spacing
i

Using MaePASCO, the stifG.,ner spacing car] b(.' optimizc_l by selecting appropriate plate widths as

design variables and by using linking (:quations. The MaePASCO display of the blade stiffener is
shown below:

MP Blade __]I

Plate Information: ]Ilelalllll : O.,:=:.:.:=:=:=:.:.:=:=_.:K.:.:.:-:,

! I

In the ligure above, plate numbers haw., b(._:n displayed using the Shay Plate Numbers option of

the View menu. Stiffener spacing can be optimized by choosing the widths of plates 1 and 2 as

design variables, and then by using linking (:quations to ensure that the width of plate 3 is equal

to the width of plate 2 and that t|n, width of plate 4 is equal to the width of plate 1.
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I Plate Design Variables ]

Plate widths are selected as design variables using the Plate Information display. Plate

information is displayed by selecting the point-hand tool in the tool palette window and double-

clicking on the desired plate, as discussed in exa_lple 1. The figure below shows the Plate

Information display for plate 1:

MP Bledo

Plato Information:

VId_ : 0 ................

aotetlea :

I _-=: L-o---

Plato Infomatlon IR]LockPleleGwmtrv

I Wldlk: 0.1 [-] hskm vwlabl,

Lover IJo..d Upper DeQlul
J(XXXXXXXXIO.,X-X.:.X@

L O.,:.:.:.:.:.:":',:'

Rotallaa: 0.00_00_C_0000

Lelalmdo: Sk_ L_ntn,te

I oK . ( ]

H

The drawing window appears in the background, and the Plate In:[ozlaation display appears in

the foreground. Clicking in Lhc box labeled Design Variable makes the plate's width a design

variable. A lower anti upper bound for the plate width can also be specified using the keyboard.

The figure below shows the Plate Information display after the plate's width has been made a

design variable and given an upper and lower bound:

MP Blade

PlateInformation:

Yld_ : 0._

Retatlee : 0 ............

|

Plata Information _] L*ck Plate Geometry

Lever bead Upper Bound

0.001 1_.

Rotation: o _ooocooooo_ooo_o

Lemkt_o: (;ktnLaminate

I[ OK l [ Cancel ]

The width of plate 2 is made a design wlriabh,' in an analogous fashion.
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I Design Variable Linking Equations]

Design variable linking equations are required in this example to enforce the symmetry of

the repeating element representing the blade stiffener and skin. Without linking equations, the

optimization process would vary the widths of plates 1 and 2, but the widths of plates 3 and 4

would remain fixed. The equations:

width plate 1 = width plate 4

width plate 2 = width plate 3

are required to link the plate widths, llena: the term, linking equation. In MacPASCO, the

equivalent equations:
width plate 1 - width plate 4 = 0

width plate 2 - width plate 3 = 0

are created. In addition, certain linking equation variables must be chosen as dependent variables.

The values of dependent variables are determined by solving the linking equations using the values

of the other independent variables. In this example, the widths of plates 3 and 4 are chosen as

dependent variabl_, and the widths of plates 1 and 2 are independent variables. Hence, as the

optimizer varies the width of plate 1, the first linking equation insures an equal width for plate 4,

and the second equation links the widths of plates 2 and 3.

MacPASCO offers a graphical linking equation editor for the creation of design variable linking

equations. The Linking Equations option of the Optimization menu, shown below, causes the
linking equation editor to appear.

cles

When this menu option is ._:le(:tcd, the linking equation editor appears a._ a new window as shown
below:

III_IIi( lJtl|l*tll

Selected Plies fer tkl,,4s

Plate B _ Linking t.,dhi...

E.....- _.
[quallel: I [ Next

AdO Plste Width ]Coefft¢ieli! _ _--] fs _ VlrS_l¢

I ShowAlIEquetlons)

The drawing of the blade stiffener appears on the h'ft, and the linking equation editor appears on

the right. For this exampl(:, the Shou Plate Numbers option of the View menu has been used so

that the plate numbers are displayed. The equation (Miter consists of a box displaying the current

equation, which appears above the words, "OK" in the figure. The box is initially blank.
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Thecreationoftheequation width plate 1 - widlh plaLc 4 = 0 begins by selecting plate 1 in

drawing window with the point-hand tool, and prc_ing the mouse button while pointing to the

box labeled "add plate width" as shown below:

MP Blade

lli_ I11_ l llqi_l|IItll\
Plato Information:

Vldtlk : O. -.............

Ootatlee : O.Cr_-=-=-------=_-=----=--_

il--rl--Q +.,..,., ,,,,..,.r
Pllte o _ Lilkill

(quetlo_

[qualiou: 1 l NeXt

C**m©lemtIT-----I [] k C_md*_va,._+

Add Rliht Hond Side I

l)elete IJllrll|l)le I

( Show All Equations J

Pressing the mouse button while pointi,g tt) the "add plate width" box expands to show a choice of
variables. 1)immcd items cannot bc st:h+,ct(+,d. I+'orexample, "add ply thickne._" cannot be selected

because a ply has not been oh(men.

The "add plate+ width" option is cho.mm, and when the mourn; button is released, plate l's width

is included in the equation as shown below:

MP Bladl

Plato Information:

+4f1411111: 0 ............

IhlM41_ : 0 ................

AClclPlate Width ]CNffl©teM [_-_ 0 IsO_N_,_t Wrt_b

[phstt +

Show All Equations

b_ample $: Blade-S+dffcncd I',mcl 8+J



Next, plate 4 is selected with the point-hand tool and added to the equation is a similar fashion,
which results in the display below:

MP Diode

I Ill Illl I I Pllht|lt_hPlato Information:

: o,_

b_ : 0 .................

i

Pl|le o _ Liakin I
[quoUoM

EqualleD: I I Next
b

Add Plate Width ic'm'le"i [] •
_1_fplate I ]

• oK . [ s.o..llEquotlon,]

Becau._ Plate 4 is to bE, u._;d a._ a dep(:rldent variable, tile box labeled "Is Dependent Variable"

is selected by pointing and clicking with tile mou._:, l_rthermore, since the desired equation is
widLh plate 1 - widLh pl_llc 4 = (), thc keyboard is used to type - 1 a._ the coefficient for the width

of plate 4 in thc linking equation. The r(_uli.ing display is shown bclow:

MpUlede__al
i Plot° 'arermotion: ] ]
IV,_ • o_ooooo_oooooooI I

I Illl', Irll I i]11 ,i |lllh "..

li4,i411

Selected Plies for 11_¢.,4
Plate # _ Linking I_l,s,,.

[llllltt e Ill _. iad*_.

(,..In..: l I Next I__"
t

Add Plate Width ]Coafhcle.l l _ k t_s_,wi_t yw4abl.

_plate ! ]

OK i . ShOWAll Equations ]

Example _: lllade-Sliffened Panel 81



Finally, the right-hand side of the equation, = O, is added. First, click to the far right of the

equation, so that no equation variabk:s are selected and the coefficient becomes zero, as shown

below:

ih5 ITl_ i ,lll,]|H_ll',

Plato " [_ LIektlw
[qestSsae

Eqltloa: I I Next

-I'[plote 41 • [plate 11 I

C Show AIIEquotlons ]

Next, 1me the "add right hand side" option _Ls shown in the first figure below. The resulting final

equation is shown in the s, cxmd figure below:

IIt_ IIII ll_l|llllt_

l IU4Q411

Selected Plies far skl_4_

Plato o _ LI ekllul |,,I.Z,,.

rqeettsee p.o ___...

OqtleUea: I I .ext

/Add Plate Width JCNfftcieet _ [--i '- C_p.n_ml vartab_.

Add Plq lhlckno_s I

Delete Uerioble ._

! _ K • C Show All Equations

t

liii I(tll _"t111,1 | Illll _

bleated Plies for f!_4;_

Plate o _ Liekiq r.

[qwatlem p,_s.,,

(q_taom: I I Next f"_'°

AddRl_htHe_dSlde i Result _l-IIsO,peM,mtVarl_l.

-I*[plote 41 * [pluto I_

IN OK it• C Show All Equations ]
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The equation width plate I - width plate 4 = 0 is complete. The equation width pla_e 2 -

width plate 3 = 0 is created in an analogot_ manner. The creation of the second equation is

initiated by pointing to the box labeled "Next" and pressing the mouse button as shown below:

Ili_ till liil,lllllll_

•. llliiq _i.PIll _ _ . , H
lq/Iol: I _ __

Add lllht Hind _11 / fTiltpliivuiiib

-t'lploto 41* Illlle I i i

( i.o. N,,e...,,.., ]

When the mouse button is relea.,_.d, a blank equation appears in the editor as shown below. The

equation number changes from 1 to 2 as an indicator that equation 2 is being edited.

I Ilillill I Itli|?|ltli_

kliilll Pllu fir _1_41

Plelt o _ tliklq loll--.

Ill'tile p.l_i

I[qwflea,: 2 I Next _i/,_l_.

C,he..,,..,,o., ]

Although this example only used plate widths in linking equations, linking equations can include
ply angles and thicknesses also.

Sizing Cycles
I

Macl'ASCO requires that the user indicate the number of sizing cycles, which determines the

number of times the optimization process iterate% using the Optimization Parameters option of

the Optimization metal, as di_l_-_d in example 1. For this example, two sizing cycles (iterations)
are _lcctcd.

Generate PASCO Code

Finally, the Hake PASC0 Code option of the File menu is used to generate the PASCO input, as

di._,ni._,d in example I. The PASCO input file generated by MacPASCO is shown on the following

page_. This text file is input to PASCO to analy_, and optimize the example panel.
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MacPASCO output for Example 2

MP Blade. INPUT

$CONDAT

$

SPANPI
B(1) = -0.8, -0.2, 1.0E30, 1.0E30,

-1.5,

BL(1)=O. 001,

BU(1)=tO000000000. O,
BL(2)-0.001,

BU(2) =t 0000000000. O,
BL(5)-O. 001,

BU (5) =10000000000. O,

IWALL(1) = 3, 2, 2, 3, 1,

AB(4, I) l -1. O,

ABCt, t) - t.o,
At(l) - 0.,

AB(3, 2) = -1.0,
AB(2, 2) - 1.0,

AC(2) = 0.,
HCARD(1) = 4, -6, S, 900, -1,

2, 121, 6,

6, 7, 1, 2, 3, -121, 4,

ICARD(1) = 5, 1, 2, 1, -990, 0000,

3, 2, 4, 2,

3, 4, 5, 3,

3, 5, 6, 4,

3, 3, 4, 6,

3, 6, -990, 0000,

EL = 30.0,

NX = 3000.0,

NY = 0.,

NXY - 0.,

MX = 0.,

PRESS = O.,

Z( 1 ) --0.004,

TL(t)=O.O0Ol,
1_(1)ml. O,

THET(l)=45.O,

MAT(1 o1)= 1,

TF._(I, 1)= 0.,

T(2)=-O. 004,

TL (2) =0.0001,
11J(2)=1.0,

THET(2)=45. O,

l_T(2,1)= 1,

TEM(2, I)= 0.,

T(3) =-0.04,

TL(3)=O. 0001,

TU(3)-1.0,

THET(3)=O.,

MAT(3,1)= 1,

TEN(3,1)= 0.,
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T(4)=-O. 01,

TL(4)=O. 0001,

TU(4)=I.0,

THET(4)=O.,

MAT(4,1)- 1,

TEN(4,1)= 0.,
T(5)=-O. O03,

TL(5)-O. 0001,

TU(5)-I.0,

T_"T(S)-O.,

_T(5,1)- 1,
TEH(6,1)= 0.,

KI,/ALL(1, 1) l 1, -1, -1, 1, 3,

)G/ALL(J, 2) - 2, -2, -2, 2, 4,

KWALLCt, 3) = 2, -2, -2, 2, S,

A11U(1) = 1.0E30,

A33U(1) = I.OE30,

DttU(t) = 1.0E30,

IP - 2,

LINK = O,

MINLAM = 30,

NOBAY = 16,

ICREP - 16,

l_UtXJJJ = 2,

$

$MATER

E1(I)- 1.90000e÷7,

PJ'IO(1)= 5.71000e-2,

ALFA2(1)- 2.18000e-5,

E2(1)- 1.89000e+6,

ANUI(1)- 3.10000e-1,

ALLOW(I,1)= 2.0, 4.00000e-3, -4.00000e-3,

-4.00000e-3, 1.00000e-2,

E12(1)= 9.30000e+5,
ALFAI(1)=-5.OOOOOe-9,

4.00000e-3,
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Exam le 3: Hat-Stiffened Panel

The third example of modeling with MacPASCO is a hat-stiffened metal panel loaded in

longitudinal compression. The panel is 20 inches long, has 3 hat stiffeners, and is subjected

to a 3000 lb/ineh eompreasive load. The four panel edges are simply supported. The panel is made
of 0.02-inch-thick aluminum plates. In this example, the panel is modeled for analysis only. The

panel is shown in the figure below (not to scale).

10.5

_ss ss ss/__ _

J

N x : 3000

Modeling this hat-stiffened panel illustrates _;veral MacPASCO features that were not shown

previonsly (examples 1 and 2). A different MacPASCO modeling tool is needed to model the hat

stiffeners. In addition, this example illustrat_._ the modeling of a metal panel, as opposed to the

composite, panels modeled previously.

Panel Geometry Modeling

in the case of the hat-stiffened panel, a single hat stiffener is chosen as the repeating substructure

which repeats three, tim(-_ across the width of tim panel. The dimensions of a single hat stiffener

are shown below:

"... 0 ..,"'°"_ _'_

iin. 78 lin.

"_}_-1._4177 in._d'_
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[ Scaling the Display [

The sale of the screen display is chosen to make drawing and manipulating the hat stiffener

as convcnicnt as possible. As discussed previously in cxample 2, the Scale Current Viov option

el" the View menu is _.'d to scale the screen display. For this example, the scale is selected as

shown below. This scale is the same scale u._ in example two.

• !

Um tke dlopleg ellovob ur.,eleVow"mdolL Tin
dktlq ehwo boy to" v_ml _pIq de plm
relstu te Ih$ plete_ width.

TO OkU |ho I1_, J_ qlog_lar ql iv _111 all •

Nml0er boqvoeroO.BO! and 1000.

Drawing the Hat Stiffcncr[

Thc grab-hand tool is iL_cd to change tt_c dimensions o1"thc initial plate clcmcnt to a width of

3.5 inch.;, the width of the hat stif[encr, a._ shown bc]ow:

f *

Notice that th_ drawing window scrolls as
the mouse is _gg_to the right. In the

figure on the left, the window has scrolled

so far to the right, that the leK side of

thc plate element is no longer visible. The

width displayed in the message box is used
as a guide.
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Once the plate element has the proper size, the user adjusts and resizes the window so that the

entire plate element is visible, as shown below:

_1 I II IIb! I I II
Philo InlrocmoUola:

R A

The add-node _,,,)1 is ._;Iccted to add nodes to the existing plate. Two nodes are added as shown

below, _uing the plate, width and rotation displayed in the message box to guide the placement of
the nodc_;

i
i Not i

Mote lafermetlom:

: i _o0go0uoooomo

I I I I II ,
Pl{1to Infoe_moliom:

VkRk : I ...............
{1etltlm : 0._-:-:-:-=_---_--:

'_ " -T- 'q

In the left-hand picture abow:, a node has been added which divides the original plate clement into

two new plate elements. In the right-hand picture, a second node has been added. The result is

three, plate elements, from h:ft to right, with widths of 1 inch, 1.5 inches, and 1 inch respectively.

Thc_e plate, el(,ments form the skin of thc hal sLiffcner.
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Next, the add-loop tool is selected from the tool palette and used to add a closed section

between two nodes on the existing model. Move the cursor over the second plate element and click
the mouse button and a closed section composed of two new plates appears, as shown below:

Hat

The left-hand picture shows the cursor positioned over the second plate element. The right-hand
picture shows the r_ult of clicking the mouse button.

This closed section is manipulated into the shape of the hat part of the stiffener. First, the

grab-hand tool is used to drag the closed section into shape as shown below:

k I n me,
1

,.. : o-,.-,..,=,,.,, ,,. : o.m,.,,.,,, i
I

Plmle InformmUen: Plate InfornmUon:

: IO.g_M.1M4S_JmSB46 Ibtatlee : iIOt.III49?_UgTIIMOB
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To complete basic geometry of the hat stiffener, another node is added using the add-node tool.
The node is dragged into place as it is added, as shown below:

Plato IBf0mmtl0E

v14tk : I ON000000OO00000

IiAathe : 0--------_----__--_---

Now the basic geometry of the hat stiffener is c_)mplcte. The exact widths and rotations must

be a_igncd to the plates forming the stiffener webs and cap. Precise widths and rotations are

specified using the Plate Information display.

First the point-hand tool is _]_:tccl in the tt)ol palette, and then the user double-clicks on a
platc as shown below:

NIle Informotlon:

: O._HIO01HGT1 nliill

: WI.I ..........

IIotidllm: i01. I I09"/24gll1711OSOS

Lalk_o: Up4em*4

In tin(; figure abov(,, the Plate In:formation display for the darkened plate appears in the
foreground.
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The keyboard is used to enter a width of 1 inch and a rotation of-78 degrees, as shown below:

Nat

II_IIHlI: -7I

LINde:

llowever, when the u_r clicks on the button labeled "OK" in the Plate Information display, the

following dialog box appears:

Hal

Plato Inriwmotloa: "' Plala lafeClnatloa

: 0.M4O02_571Z_JXll Plata Infermotloa _LNkPkdeGeea_rlrq
OJtettil : lot ,ImlrT"J4NITIHi6_

! _4th: 1 r'_ D_lt_ Yir table
Ii_r I....i mlr lL.m.,

O ,i-_-:R,,Tkle plato'e width and/at rotation

calil1_l ba adJu|lad without

ellarln9 a rigid plate

R

The dialog box is dismias[_ by clicking on the button labeled "OK." The error message appears

becau._ changes to a platx:'s width and/or rotation using the Plate Information display should
not alter the widths or rotations of any other plat(_, as di_u._ed previously in this manual. As

shown in the figure b(:low, it is not p(_sit)lc to alter the width and/or rotation of a plate in a closed

section without altering the width and/or rotatiorl of at least one other plate.

rivkl
c_ rigid ? ri_lid

\ /,'°
/--error- dimensions cannot

change

Example _: 1�at-Stiffened Panel 91



in thissituation, one can un/ock a plate so that the plate dimensions change to accommodate

changes to adjacent plates. Plates arc unlocked using the Plate In_onmation display. In the

figures below, the plate forming the cap of the plate is unlocked by clicking on the box labeled
"Lock Plate Geometry." When a cross appears in the box, the plate is locked. When no cross

appears, the plate is unlocked. Clicking on a crossed box unlocks the plate and removes the cross.

Clicking on an uncrcx_d box locks the plate and adds the cross.

!PIoIo IiiIonnllloil

M i i JOOIOOOOO41OOBtD

kt

Pli4e IIl|lrmltle In_l.ad PkkOPn*rl
..q

Wl4tk: I.ooomommoooooe nO_dpWrtob

I.*vor Ilewu WqHwrhqmd

_o: Ulldoql_wd

J

Plolo Inlofm|Uen:

Plato InfonNflN. _

Once the plate forming the cap is unlocked, the two plate_ forming the webs of the hat stiffener
can be adjusted using the Plate Infor_atLon display as shown below:

Nel Net

Plllo Inrormollon;

PIoLo Inlormotto_ [] LookPlo_oOm0o(rv Vgd_ : O_*_O_
Oto4ot_Jo_ : 74_145_1NW_1_1_|

_er Jnm_ Upl_r heed

Oote_oe: -70

_e: thtdeCt_t

t...iK..J

P1Qte lllf_tl_ _ _eck _Qt_tr_

Lever bred UPIwr Ileemd

O.')'_X.X_, n00000000_ .,X.'.e_..'._(*:*

ilotetloll: 15

Lee:

In the h:ft-hand figure above, the dimensions for the left web of the hat are defined. In the right-

hand ligure, the change to the left web of the hat is visible and one can also see how the cap of

the hat has changed dimension to ae_mmodatc the cF,ange. Also, the dimensions for right web of
the hat art,, defined.
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The linal hat-stif[cner geometry is shown in the figure below:

Hat

Plato Information:

Vldth : l).:.:.:-:.:.:.:-:.:.:.:-:-:,,'.'.:.:,

Aotittkm : 0.:.: :.:, :,,:,,:,,:.:-:.:.:.:.'<.:.:,

l

7

Rcpc_lting Elements

The Ntmber of Repeating Elements option of the Panel menu is tL_d to spccify that the hat

still'cncr is repeated thr(._: time_ a_:ro._ the width of tim panel. Selecting the Ntmbar of Repeating

Elements option prompts for the number o1"repeating elements. The prompting dialog box is shown

below after three repeating elemcnL_ are specified.

Panel Length and Loads

The panel loads and I(:rigth arc specified using the Apply Panel Loads option of the Panel menu.

In this case, the panel length is spccifi(.ul as 20 inch(_ arid 3000 Ib/inch is also entered as the N=
load as shown below:

,ll_+ i ,i,u,l,

____//r' /Z.,,
l°""" ! #_" - (° f

I'°''°'°''°° I
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Boundary Conditions

Boundary conditions on the lateral edges of the panel are specified using the node information

dialog box, as discussed previously in this manual. In this case, simple-support boundary conditions
are chosen, as shown previously in example 1 of this manual.

Metal Definitions

in the case of metallic panels, MacPASCO (and i)ASCO) uses a "laminate" of isotropic material.

For this example, the hat stiffener is made of 0.02-inch-thick aluminum. First, the material

properties for aluminum must be defined, next a single ply of 0.01-inch-thick aluminum is defined,

and lastly, a "laminate" composed of two 0.01-inch-thick plies is defined to form a 0.02-inch-thick
aluminum "laminate."

As discussed previously in examples 1 and 2, ply materials are defined using the Def£ne Ply
Haterials option of the Laminates menu. However, MacPASCO includes the material properties

of aluminum by default, so no input is required. Thc figure below shows the default material

propcrtk_ for the ahlrninum supplied by MacPASCO:

l'leterlQl Iklme _luminum

E, I,OOooooo.o I*"U' Io.s
Ez i,ooooooo.o j A,r,, io.o
_Iz[3osoooo.o j ,Lr,Z [o.o
=.o Io., I

I
I

Material Failure Crlterlon and Allowables

Criterion:[ Stress I

ol compression150000.0 I

o'l teflon [- 50000.0 J

a2 ¢empre=sion[soooo.o j
=Z teflon I-SO00O.O i

'v12sl_=r _tO000.O J
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Next, an aluminum ply is defined using the Define Plies option of the Laminates menu.
Since the details of ply definition were discussed previously in the Ply Definition section of example

1, thc following figure only shows the ply information display:

pawm.mo:Pm_v )

iAlillO: IO.OOO000000 'J rl hi, govorloldo

Lvvor lkimi UpImtr hqmtil

ooooo,',,_o j Iooooooooo I

TblckNm|: I0.01 I I--] DeadOmVorlokle

Lvvnr bun UpMr hlld

loooooo°_o I I_°°°°°°°° I

Malarial Tomporoturo

p.O0000000

I,'inally, an aluminum laminate is created using the Define Laminates option of the Lam-

inates menu. Since laminate definition was discu._:d previotLsly in example 1, only the final

stacking sequence is shown below.

LIIIli lifo: _iUm

tool Mtoo oro compoml of •
flick of pIl*t. The I1ol bolev
shows the STACKING S[QU[_E

for this lomineto,

STACI(ING SF.QUENC[

lllti_ly 0.011000

oomete

] Tnd©knms:[o.o2oooooo ]
Point end click to Ioloct m ply
from the 11st bolov, then copv

tM ply Into the STACKING
SEQU[NCE with the copg b_Ion.

POSSIBLE PLIES

Delete the selected PlU Onlv plhm that hevo boon
• prevtsullU doflned ore shown.

(Change Sign)change sign of the seloctandply'l angle.
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Onc_ the aluminum laminate is defined, it is associated with the stiffener geometry. A detailed
discussion of this process appears in cxample 1. The plates which form the hat stiffener are selected

with the point-hand tool. Next, the Assign Laminates to Plates option of the Laminates
menu is used and the "Alum" laminate is selected from the laminates window as shown below:

Select • Lamlnele

Clicking on the button hd)cled "OK" assigns the aluminum laminate to the hat stiffener.

proc_._s (._)mplct(m the material property definitions r(:quired for the hat stiffener.

Buckling Mode Wavelength

This

As discussed previously in examplcs 1 and 2, the minimum buckling load half-wavelength, A, is

spccifi(:d by using ttl(."Eigenvalues m(:nu option of the Panel menu. For the hat-stiffened panel,

A = 20 is specified.

Generate PASCO Code
II

Finally, the PASCO input is generated by using the Make PhSC0 Code option of the File menu,

as discussed in examph;s 1 and 2. The I)ASCO input file generated by MaePASCO is shown on

the following page. This text file is input to PASCO to analyr_e and optimiT_ the example panel.
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MacPASCOoutputforExample 3

Hat. INPUT

$CONDAT

$

$P*NEL

B(1)- 1.0, 1.5, 1.0, 1.0,

1.084177, 1.0,

IWALL(1) - 1, 1, 1, 1, 1, 1,

HCARD(1) = 4, -7, 4, 2820, -1,

4, -8, 6, 780, -1,

4, 9, 7, 5, 8,

5, 10, 1, 2, -9, 3,

ICARD(1) = 3, 1, 2, 1,

5, 2, S, 2, 3, 7,

3, 5, 6, 3,
3, 3, 4, S,

3, 4, 5, 8,

EL = 20.0,

NX = 3000.0,

NY = 0.,

NXY = 0.,

MX - 0.,

PRESS = O.,

T(1)-0.01,

THET(1)-O.,

MAT(I,I)= I,

TF__(1,1) l 0.,

_ALL(1, 1) - 1,
AIIU(1) = I.OE30,

A33U(1) = 1.0E30,

DIIU(1) - I.OE30,

IP - 2,

LINK - O,

MINLAM = 1,

NOBAY = 3,

ICREP l 3,

$

$MATER

El(l)- 1.00000e+7,

RHO(1) l 1.00000e-1,

ALFA2(1)=O.,

E2(I)- 1.O0000e+7,

ANUI(1) I 3.00000e-I,

ALLOW(I,1)- 1.0, S.O0000e÷4, -S.O0000e+4,

-S.O0000e+4, 4.00000e+4,

E12(1)= 3.85000e+6,

ALFAI(1)=O.,

8.00000e+4,

Example _h liar-Stiffened Panel 97



References
• I I II I

1. Anderson, M.S.; Stroud, W. J.; l)urling, ILJ.; and llennessy, K.W.: PASCO: Structural Panel

Analysis and Sizing Code, User's Manual. NASA Technical Memorandum 80182, November
1981.

2. Stroud, W.J.; and Anderson, M.S.: PASCO: StructuralPanel Analysis and Sizing Code,

Capabilityand AnalyticalFoundations.NASA TechnicalMemorandum 80801, November 1981.

3. Lucas, S.H.; and Davis, Randall C.: User's Manual for the Macintosh Version of PASCO. NASA
Technical Memorandum 104115, September 1991.

4. l,uc_m, S.II. and Davis, Randall C.: MacI'ASCO: A Macintosh-based, Interactive Graphic Pre-
proc_-ssor for Structural Analysis and Sizing, AIAA/ASME/ASCE/AHS/ASC 32 nd Structures,

Structural Dynamics, and Materials Confcrcncc, Baltimore, MD, April 8-10, 1991. AIAA Paper
91-1208.

References 98





Form Approved

REPORT DOCUMENTATION PAGE OMB NO. 0704-0188

i

PUt_IIC reloottln 9 burden for thts _ i,Ilectlon Of information is estimated To avefa(]e 1 hour per resl_)n_e, including the time for reviewing instfuctIons, searching ex#stir_cj data $oufc¢_,

cjathermq and mamtaln._,] the d._,,l needed, and cOmpletinq and r_vJew*ng the collerlton of information S_,nd comments regarding this I_lfden estimate or any other asC_=ct of this

(allen,=on of infotm=l*un, _n¢ludlncj _ucj_jeStlons tar redu(llt_ thl_, burden. ,o Wash,ncJton _leadquaf(ers Serul(es. Directorate for Information Operations and Reports, 1215 Jefferson

Davis Highway. Suite 1204. Arlmcjtc_n. VA 2.1202-4302, .tnd to thP Otfi_ e of M<macjement _nd Budget. Paperwork Reduction Pro ect (0704-0188). Washington, OC 20503.
i i

1. A6ENCY USE ONLY (Leave blank) 2. REPORT DATE

February 1992
4. TITLE ANI) SUBTITLE

User's Manual for MacPASCO

6. AUTHOR(S)

S. H. Lucas and R. C. Davis

7. PERFORMINGORGANIZATIONNAME(S)ANDADORESS(ES)

NASA Langley Research Center

Hampton, VA 23665-5225

9. SPONSORING/MONITORINGAGENCYNAME(S)ANOADORESS(ES)
National Aeronautics and Space Administration

Washington, DC 20546-000]

3. REPORTTYPEANDDATESCOVERED
Technical Memorandum

5. FUNDINGNUMBERS

WU 506-43-71-05

8. PERFORMING ORGANIZATION
REPORT NUMBER

10. SPONSORING / MONITORING

AGENCY REPORT NUMBER

NASA TM-I04122

It. SUPPLEMENTARYNOTES
S. H. Lucas: Analytical Services and Materials, Inc.,

R. C. Davis: Langley Research Center, Hampton, VA
Hampton, VA

121.DISTRIBUTION/AVAILABILITYSTATEMENT

Unclassified - Unlimited

Subject Category - 61

12b. DISTRIBUTION CODE

13. ABSTRACT (Maximum 200words)

This document is a user's manual for MacPASCO. MacPASCO is an interactive,
graphic, preprocessor for panel design. MacPASCO creates input for PASCO, an
existing computer code for structural analysis and sizing of longitudinally stiffened
composite panels. MacPASCO provides a graphical user interface which simplifies
the specification of panel geometry and reduces user input errors. The user draws the
initial structural geometry on the computer screen, then uses a combination of graphic
and text inputs to: refine the structural geometry, specify information required for
analysis such as panel load and boundary conditions, and define design variables
and constraints for minimum-mass optimization. Only the use of MacPASCO is
described herein, since the use of PASCO has been documented elsewhere.

r

14. SUBJECT TERMS

Stiffened Panels, Structural Design, Composite Structures,

Computer Software, Design Tools, PASCO, CAD

"17. SECURITY CLASSIFICATION 18. SECURITY CLASSIFICATION

OF REPORT OF THIS PAGE

Unclassified Unclassified

NSN 7540-01-280-5500

19. SECURITY CLASSIFICATION
OF ABSTRACT

15. NUMBER OF PAGES

102

16. P_(_ CODE

20. LIMITATION OF ABSTRACT

Standard Form 298 tRey 2-89)
Prescribed by ANSI Std. Z]g-t8

298-102






